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Avant-propos

Ce manuel a été créé par Hologic®, Inc. Il est destiné a guider I'utilisateur sur la fagon de configurer, d’installer et d'utiliser le
matériel Faxitron Path et le logiciel Vision, tous deux développés par Hologic®, Inc.

Faxitron Path était auparavant connu sous le nom de PathVision.

L’utilisateur doit d’abord configurer le matériel, puis lancer le logiciel Vision. Veuillez consulter les procédures de configuration
requises dans la Section 2 de ce manuel avant de continuer.

Indications d’utilisation

Le Faxitron Path est un systéme de radiographie monté dans une armoire, utilisé pour fournir des images sur film et/ou des
images radiographiques numériques d’échantillons provenant de diverses régions anatomiques afin de vérifier rapidement que
le tissu correct a été excisé durant la biopsie. La possibilité de procéder a cette vérification directement dans la méme piéce ou
a proximité de celle ou la procédure est effectuée accélére le déroulement des opérations et réduit ainsi la durée nécessaire a
I'examen du patient. La radiographie d’échantillons peut potentiellement limiter le nombre de rappels de patients.

v'Utilisation sur ordonnance (Partie 21 CFR 801, sous-partie D).
Attention : les lois fédérales américaines limitent la vente de ce dispositif par un médecin ou sous prescription médicale.
Le systeme peut fonctionner comme un dispositif autonome. Si le dispositif est connecté a un réseau, il est essentiel de mettre

en ceuvre des mesures visant a réduire le risque pour les patients en diminuant la probabilité que les fonctionnalités dudit
dispositif soient intentionnellement ou non compromises par une cybersécurité inadéquate.

(1]

www.hologic.com/package-inserts
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SECTION 1
Introduction
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Systéme de radiographie d’échantillons Introduction
Ce manuel a été créé par Hologic, Inc. Il est destiné a guider I'utilisateur avanceé sur la fagon
de configurer, d’installer et d’utiliser le matériel Faxitron Path et le logiciel Vision, tous deux .
développés par Hologic, Inc. Introduction
Lisez attentivement toutes les informations avant d'utiliser le systéme. Respectez tous les
avertissements et toutes les précautions énoncés dans ce manuel. Conservez ce manuel a
disposition pendant les procédures. Respectez toujours toutes les instructions de ce
manuel. Hologic, Inc. décline toute responsabilité en cas de blessure ou de dommage
résultant d’une utilisation incorrecte du systéme. Hologic peut vous proposer une formation
dans votre établissement.
Merci de la part de nous tous a Hologic, Inc.
Fabricant et coordonnées
SPONSOR AU
Hologic, Inc. Hologic (Australie et Nouvelle-Zélande) Pty Ltd.
600 Technology Drive Suite 302, Level 3
Newark, DE 19702 USA 2 Lyon Park Road
1.800.447.1856 Macquarie Park NSW 2113
www.hologic.com Australia
1.800.264.073
Hologic BV
Da Vincilaan 5
1930 Zaventem
Belgique
Tél.: +322 711 46 80
Fax:+322 72520 87
Les symboles suivants sont utilisés dans ce manuel et dans le systéme d’aide en ligne :
Symboles
Avertit le lecteur d’un risque d’électrocution s’il ignore I'avertissement et utilise d’avertissement
deélibérément des outils spécialisés pour ouvrir une armoire électrique scellée et de mise en
et manipuler son contenu. AN Remarque : aucun outil n’est fourni par Hologic, garde de ce
Inc.
manuel

Avertit le lecteur d’'une situation dangereuse. Ce symbole est généralement
accompagné d’'un symbole plus spécifique et d’instructions appropriées
concernant la nature du danger, I'issue prévisible du danger et les informations
permettant d’éviter le danger.

Incite le lecteur a faire preuve de prudence lorsqu’il souléve du matériel lourd
afin d’éviter les blessures corporelles et les dommages matériels.

Avertit le lecteur qu’un rayonnement ionisé est émis dans la zone marquée
lorsque le faisceau de rayons X est activé. Le Faxitron Path est doté de
dispositifs de verrouillage de sécurité pour empécher I'accés a la zone marquée
pendant que le faisceau de rayons X est activé.

Avertit le lecteur qu’il doit utiliser une protection appropriée (comme des gants
chirurgicaux ou un récipient pour échantillon approuvé) pour éviter I'exposition
a des matiéres potentiellement infectieuses comme les échantillons de tissus
des patients.

BB >
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SECTION
Systéme de radiographie d’échantillons Introduction
1.1.1
Symbole Description Norme Symboles
; .
Débarrassez-vous du Directive DEEE d avertl_ssement
matériel électronique et 2012/19/UE et de mise en

| <

électrique séparément des
déchets normaux.
Renvoyez le matériel hors
service a Hologic ou
contactez votre
représentant du service a la
clientele.

Fabricant

1SO 15223-1,
référence 5.1.1

Date de fabrication

1SO 15223-1,
référence 5.1.3

Rayonnement ionisé émis | 1SO 7010,
lorsque le faisceau de référence W003
rayons X est sous tension

Avertissement, utiliser une |[ISO 7010,
protection appropriée référence W009
Avertissement Electricité CEI 60417,

référence 6042

Avertissement

I1SO 7010,
référence W001

= B BB B R

www.hologic.com/package-inserts

Consulter le mode
d’emploi

1SO 15223-1,
référence 5.4.3

Respecter le mode d’emploi

CEI 60601-1,
référence tableau
n° D.2, signe de
sécurité 10

(ISO 7010-M002)

Ce systeme transmet de
I'énergie RF
(radiofréquence)
(rayonnements
électromagnétiques non
ionisants)

CEI 60417,
référence 5140

garde sur les
étquettes
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Faxitron® Path

Systéme de radiographie d’échantillons Introduction
Symbole Description Norme
Représentant autorisé au ISO 15223-1,
EC |REP sein de I'Union européenne | référence 5.1.2
Dispositif médical ISO 15223-1,
MD référence 5.7.7

Numéro de catalogue ISO 15223-1,
référence 5.1.6

Numéro de série 1SO 15223-1,
référence 5.1.7

Pays de fabrication ISO 15223-1,
référence 5.1.11

i e | B

- - Traductions dans I'encadré |Hologic
Translations in Box

Mise en garde ISO 15223-1,
référence 5.4.4

Limites d’humidité 1SO 15223-1,
référence 5.3.8

Certification ETL Conseil canadien
des normes (CCN)
et Administration

D) @) >

américaine de la

LisTED
_— sécurité et de la
Intertek santé au travail
(OSHA)
Utilisation uniquement sur |FDA 21 CFR
IiON LY ordonnance 801.109
Courant alternatif CEI 60417,
N référence 5032
Marquage CE Reglement RDM
c € Conformité européenne (UE) 2017/745

Avertissement ; rayon laser |ISO 7010,
& référence W004
HOLOGIC
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SECTION
Introduction

Symbole

Description

Norme

Bus universel en série
(USB), port/prise

ISO 7000-3650

Mise en garde — Hologic
Rayonnement

(production de rayons X)

Fusible CEI 60417,

référence 5016

Terre (masse)

CEI 60417-5017

S SUSIRIRE AP

Faire attention lorsque vous | Hologic
soulevez des objets lourds
Remarque Hologic
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SECTION 2
Installation et
configuration du
Faxitron Path
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Faxitron® Path

Systéme de radiographie d’échantillons

Installation et
configuration

Avertissements
o Veuillez lire attentivement les instructions avant d’utiliser le systeme.

o N'utilisez pas le systéme d’'une maniére autre que I'utilisation prévue, comme décrit dans
ce manuel. En cas de doute, contactez Hologic ou votre distributeur agréé.

e Tous les cordons d’alimentation ne sont pas prévus pour la méme puissance. N'utilisez pas
d’autre cordon d’alimentation avec ce systéme que celui fourni. N'utilisez pas le cordon
d’alimentation de ce systéme sur un autre équipement.

o Ce systeme a été testé conformément aux normes internationales les plus exigeantes ;
toutefois, il est recommandé de contacter les autorités nationales en ce qui concerne les
exigences opérationnelles locales.

o Ce systeme n’est pas destiné a une utilisation publique. 1l doit étre situé dans une zone ou
le grand public ne peut pas accéder au systéme sans la présence d’un opérateur.

Précautions générales
Les précautions suivantes doivent étre prises pour éviter d'endommager votre systéeme Path :

e Ne connectez ou déconnectez jamais les cables de communication et/ou d’alimentation
lorsque le systeme de caméra est sous tension. Des dommages au détecteur CMOS ou a
I'électronique de la caméra peuvent survenir siles cables sont connectés/déconnectés alors
que l'appareil est sous tension.

e Le systéeme de la caméra est fragile et des précautions doivent étre prises pour ne pas
endommager la caméra. Le systéme de la caméra ne doit jamais étre malmené, heurté,
cogné ou laissé tomber.

e Le systeme Path dispose d'un mode d'étalonnage. L’étalonnage doit étre effectué
quotidiennement pour assurer le bon fonctionnement du systeme. Veuillez vous reporter a
la procédure d’étalonnage.

* Mise en garde : I'utilisation de commandes ou de réglages pour effectuer des procédures
autres que celles spécifiées dans le présent document peut entrainer une exposition a un
rayonnement dangereux.

Connexions interopérables

Le Path peut fonctionner comme un dispositif autonome sans aucune entrée ou sortie vers
d’autres dispositifs. Les images peuvent étre capturées, stockées et examinées directement
sur le systéme.

Toutefois, le systéme est livré avec plusieurs interfaces. La principale est la connexion réseau
qui permet au systéme d’'étre connecté a un systéme d’archivage et de transmission d’images
(PACS, Picture Archiving and Communication System). Les images peuvent ensuite étre
transmises au format DICOM du dispositif directement au réseau de I'établissement via notre
logiciel. Voir Section 6 pour plus de détails sur la version DICOM. Seuls des employés de
Hologic ou le personnel informatique qualifié de I'établissement de I'utilisateur doivent
configurer cette communication.

Les connexions du systéme et leur utilisation prévue sont indiquées ci-dessous. Aucun autre
type de dispositif ne doit étre connecté au Path sans I'approbation de Hologic.

Précautions et
avertissements
relatifs au
systéme

I\
A

A\

Raccordement | Usage Type de dispositif Utilisateur prévu
Port Ethernet a Pour stocker des images radiographiques PACS ou stockage en | Configuré par le personnel de
I'arriére sur un réseau de stockage de données. réseau Hologic ou du service

informatique de I'établissement.
Utilisé par les cliniciens.

Port Ethernet a Pour permettre une connexion a distance de | Connexion internet en | Personnel de Hologic ou du

I'arriere I'équipe d’entretien de Hologic, a des fins de | réseau service informatique de
diagnostic et de réparation du systéme. I'établissement.

Port USB a Pour transférer des images a partir du Périphérique de Cliniciens ou personnel du

I'avant dispositif. Il ne doit étre utilisé que si le stockage USB service informatique ayant un
PACS ou le réseau n’est pas disponible. (clé USB) acces autorisé au systéme.

HOLOGIC
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Faxitron® Path

Installation et

Systéme de radiographie d’échantillons configuration
Raccordement | Usage Type de dispositif Utilisateur prévu
Port USB a Pour assurer la maintenance et I'entretien Périphérique de Personnel de Hologic ou du

I'avant du systéme, il peut étre nécessaire de stockage USB service informatique de
I'établissement.

copier les fichiers sur I'ordinateur et a partir | (clé USB)
de celui-ci. Par exemple, les mises a jour du
logiciel ou les fichiers journaux.

Port USB a Pour permettre la connexion d’une Imprimante DICOM

connecter une imprimante DICOM ou une
imprimante standard compatible Windows.

Cliniciens ou personnel du
I'arriere imprimante. Le logiciel Vision permet de ou Windows service informatique de
I'établissement.

Cybersécurité

La sécurité des dispositifs est une responsabilité partagée entre Hologic et les
établissements de santé. L’absence de maintien de la cybersécurité peut entrainer une
compromission des fonctionnalités des dispositifs, une perte de disponibilité ou d’intégrité
des données (médicales ou personnelles) ou I'exposition d’autres dispositifs ou réseaux
connectés a des menaces de sécurité. Hologic effectue un ensemble de contrOles de
cybersécurité pour garantir la cybersécurité de ses unités et pour assurer leur fonctionnalité
et leur sécurité.

Toutes nos unités utilisent le systéeme d’exploitation standard Windows. Lors de I'installation,
nous recommandons a I'établissement de mettre en place toutes les mesures de sécurité
nécessaires définies par ses propres exigences internes, comme il le ferait pour tout autre
PC connecté au réseau.

L’établissement peut configurer le systeme d’exploitation Windows avec tous les protocoles
de réseau et les autorisations nécessaires. Par exemple, ils peuvent ajouter :

« D utilisateur et mots de passe.
»  Autorisation par couches avec authentification appropriée.
* Restrictions sur les installations de logiciels.

+ Exigences relatives au contenu de confiance, y compris la vérification de la
signature du code.

»  Configurer les mises a jour de Windows, y compris les versions de sécurité.

En outre, notre logiciel d'imagerie (Vision) peut étre protégé par un mot de passe, de sorte
que certains utilisateurs peuvent accéder au systeme d’exploitation sans pouvoir ouvrir le
logiciel Vision.

L’unité est livrée avec une clé physique qui permet d’activer le systéme de radiographie.
Cela permet au systéme d’étre verrouillé, de sorte que méme si 'on accede au logiciel,
aucune radiographie ne peut étre lancée.

Cette unité est congue pour étre utilisée soit comme une unité autonome, soit pour étre
connectée au PACS interne de I'établissement ou a un autre réseau en boucle fermée. Elle
n’est pas destinée a étre connectée a Internet, @ moins que (a) I'établissement recoive des
instructions spécifiques de la part de Hologic, ou que (b) I'établissement prenne des
précautions adéquates pour assurer sa cybersécurité face aux menaces liées a sa
connexion a Internet.

Hologic développera des mises a jour ou des correctifs pour le logiciel Vision afin de
continuer a assurer la sécurité du produit, selon les besoins tout au long du cycle de vie de
l'unité.

Des mesures de sécurité supplémentaires, notamment le cryptage, peuvent étre mises en

ceuvre et Hologic peut travailler avec le département informatique des établissements pour
réduire le risque pour les patients a la suite d'une violation de la cybersécurité.

A
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Installation et
configuration

Nettoyage
Chambre interne

Les échantillons contenant des échantillons biologiques peuvent abriter des agents
infectieux dangereux pour votre santé. Suivez les procédures de biosécurité appropriées :
portez des gants lors de la manipulation des échantillons de tissus ou de tout matériau avec
lequel ils sont entrés en contact.

Essuyez régulierement l'intérieur de I'armoire avec de I'alcool isopropylique a 70-90 % ou
avec de I'hypochlorite de sodium dilué (5,25-6,15 % d’eau de Javel domestique diluée a
1:500 fournit la concentration appropriée). Veillez a ce que la zone de I'échantillon, indiquée
sur le sol de la chambre, soit nettoyée a fond.

Chambre externe

Essuyez réguliérement les surfaces externes avec de 'alcool isopropylique, de I'hypochlorite
de sodium ou du savon doux et de l'eau. (Voir ci-dessus pour les concentrations
appropriées.) Ne trempez pas ou n’inondez pas les surfaces et n’utilisez pas d’abrasifs qui
pourraient rayer les surfaces. Ne laissez pas I'humidité entrer en contact avec les
composants électriques du systéme. Testez les produits de nettoyage sur une petite zone
non visible des capots en plastique et en métal pour vérifier qu’ils n'endommagent pas le
revétement.

Inspection des caisses

Le systeme Faxitron Path est livré dans une grande caisse en bois et dans une boite.
Demandez a 'agent de transport de déposer la caisse et la boite dans une zone a I'abri du
vol, des dommages ou des conditions environnementales extrémes, jusqu’a ce que le
représentant autorisé de Hologic puisse installer le systéme.

Vérifiez si la caisse et la boite sont endommagées. Si 'une des deux semble endommagée,
contactez Hologic au 1-800-447-1856.

La caisse fait environ quatre pieds (1,20 m) de haut. Cette caisse contient I'unité d’analyse
des échantillons, I'ordinateur et les manuels du systéme. La boite contient le moniteur du
systéme.

Levage et transport de la caisse

Attention : la caisse pése environ 550 livres (250 kg). Le systéme emballé doit étre maintenu
en position verticale, comme indiqué sur la caisse d’expédition.

Déballage et assemblage du systéme

Le systéme Faxitron Path doit étre déballé et installé par un représentant autorisé de
Hologic, Inc.

Emplacement

Le systeme Faxitron Path est doté d’une ventilation et le connecteur d’entrée d’alimentation
se trouve a l'arriére de I'armoire. Laissez au moins 6 po (15 cm) d’espace libre derriére I'unité
une fois installée pour permettre a I'air de circuler et pour permettre a 'utilisateur d’y accéder
pour débrancher le cordon d’alimentation.

Configuration du
systéme
Faxitron Path
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Installation et
configuration

Conditions environnementales

En fonctionnement :
Température : 15,5 @ 30 degrés C ou 60 a 86 degrés F.
Humidité relative : <75 %

Stockage et transport :
Température : 0 a 45 degrés Cou 32 a 113 degrés F.
Humidité relative : <75 %

Cet équipement a été congu pour les conditions suivantes :

Utilisation intérieure.

Altitude jusqu’a 2 000 métres.
Degré de pollution 2.
Surtension, catégorie II.

Le Faxitron Path ne doit pas étre déplacé une fois installé. Le systéme a été congu comme
un systéme fixe a installer sur un comptoir ou une table.

RADIOPROTECTION

Armoire blindée contre les rayonnements.
Porte de compartiment équipée d’'un double verrouillage de sécurité.
Rayonnement : moins de 0,1 mR/h a5 cm (2 po) de la surface extérieure a kV maximum.

Certifié conforme aux normes établies par la US Food and Drug Administration, Center
for Devices and Radiological Health, (21 CFR 1020.40).

Congu pour étre conforme aux normes établies par Underwriters Laboratory aux Etats-
Unis et au Canada.

Hologic recommande aux utilisateurs de suivre une formation en matiere de protection
de base contre les rayonnements ionisants avant d'utiliser le systéme.

CONTROLE DE L’EXPOSITION : Automatique ou manuel.
CYCLE D’UTILISATION DES RAYONS X : 50 %.
INFORMATION SUR LE LASER : Produit laser de classe 2.

CEIl 60825-1 Ed. 3.

Conforme aux normes 21 CFR 1040.10 et
1040.11, sauf pour les déviations en vertu de
I’Avis sur les produits laser numéro 50, daté
du 24 juin 2007.

CARACTERISTIQUES ELECTRIQUES :  100-240 V CA, 50/60 Hz, 200 VA max.
PRODUCTION DE CHALEUR : 500 BTU/h max.

Fluctuations de la tension d'alimentation secteur - +10 % de la tension nominale

Spécifications du tube a rayons X :

Tache focale < 12 microns

Tension - 20 a 100 kV

Puissance - 12 watts maximum
Champ de rayonnement - 45 degrés
Cycle d'utilisation des rayons X : 50 %

Spécifications

HOLOGIC
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION
Installation et
configuration

kY Courant du faisceau (m#A) | Puissance (W)
20 0,375 15

30 0,375 11,25
40 03 12

2 0,24 12

60 02 12

70 0,171 12

B0 0,15 12

a0 0,133 12
100 0,12 12

DIMENSIONS EXTERIEURES (approximatives)

Courant du faisceau (mA)

2.3.0 Suite

Plage de fonctionnement des rayons X

Tension du tube (kV)

@ Courant c faiscea (mA) —@— Puissance (W)

cm pouces
Taille 90 36
Largeur 59 23
Profondeur 54 21

DIMENSIONS INTERIEURES DU COMPARTIMENT (approximatives)

cm pouces
Taille 57 22,3
Largeur 39 15,5
Profondeur 42 16,5

POIDS (approximatif)

Avec ordinateur, moniteur, clavier et accessoires
kg Ibs

Net 210 465

Expédition 258 570
Armoire uniquement

Net 188 415

Expédition 236 520

HOLOGIC
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] SECTION 3
Etalonnage de la cameéra

HOLOGIC

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | REVISION 002 3-1




Faxitron® Path Eronons de

Systéme de radiographie d’échantillons la caméra
Etalonnage 3.1.0
Lors de la mise en service initiale du systéme ou a n’importe quel moment souhaité par Etalonnage

I'utilisateur, un étalonnage du systéme peut étre effectué. Il est recommandé d’effectuer les
étalonnages suivants lors de la mise en service initiale et toutes les douze (12) heures.

Pour optimiser la qualité de I'image, le logiciel Vision et le matériel nécessitent un étalonnage
périodique. Cet étalonnage nécessite I'acquisition d'images de référence. Ces images peuvent
étre regroupées en trois (3) catégories : images décalées, images sombres et images du
champ plat.

Le logiciel Vision s’ouvrira directement au menu d’accueil (Figure 3.1.1) ou a la page
d’étalonnage (Figure 3.1.2) en fonction du temps écoulé depuis le dernier étalonnage.
L’utilisateur peut naviguer jusqu’a la page d’étalonnage afin de lancer manuellement un
étalonnage.

Attention : vérifiez que la chambre est vide avant de commencer I'étalonnage.

Pour démarrer manuellement I'étalonnage, cliquez sur le bouton « Calibrate » (Etalonnage)
dans le menu d’accueil.

Start Procedure

>

Calibrate Review Shut Down

2019/02/01 13:31:39 Fri

L'utilisateur sera alors invité a lancer I'étalonnage.

Start Calibration

Last Calibrated: 201 7/31 14:41:53 Tue

ENSURE THE CHAMBER IS EMPTY BEFORE CALIBRATION

Calibration before beginning any procedure is recommended

Une fois ce bouton pressé, le processus d’étalonnage est effectué et la boite de message
d’étalonnage s’affiche. Pendant I'étalonnage, la boite de message affichera « SYSTEM IN
CALIBRATION » (Systéme en cours d’étalonnage) et « X-RAY ON » (Rayons X activés). Voir
Figure 3.1.3.

Calibrating

‘5‘ SYSTEM IN CALIBRATION

Le logiciel reviendra automatiquement au menu d’accueil a la fin de I'étalonnage.

Reportez-vous aux sections 5.2.0 et 5.2.1 pour plus d’'informations sur I'étalonnage.

Figure 3.1.1 )
Bouton Calibrate (Etalonnage)

Figure 3.1.2
Invite de démarrage
d’étalonnage

Figure 3.1.3
Etalonnage en cours

HOLOGIC

MANUEL DE L’UTILISATEUR DU FAXITRON PATH | HOLOGIC | REVISION 002

3-2



Faxitron' Path

Systéme de radiographie d’échantillons

SECTION 4

Démarrage rapide —
Fonctionnement de base
du Faxitron Path
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Faxitron’ Path Démarrage

Systéme de radiographie d’échantillons rapide

Avant de mettre le systéme sous tension, veuillez vous assurer que tous les cordons et les

cables sont bien branchés sur le systéme, I'ordinateur et I'écran. Démarrage rapide

Reportez-vous a la Section 2, Installation et configuration, du présent manuel, ainsi qu’aux
guides d’installation et de démarrage rapide fournis avec votre systéme Path.

Figure 4.1.1
Panneau avant du Path
Clé marche/arrét
Protocole applicable a la séquence de démarrage du systéme
Cette séquence de démarrage doit étre respectée pour assurer le bon fonctionnement du
systeme et la qualité de I'image.
Mise sous tension du systéme :
e Placez l'interrupteur situé a I'arriere de 'armoire Path sur la position « MARCHE ».
e Tournez la clé située a l'avant de I'armoire Path sur « MARCHE » (dans le sens des
aiguilles d’'une montre jusqu’a la position correspondant a trois heures).
e Allumez 'ordinateur et I'écran.
Démarrage du logiciel :
J G Figure 4.1.2
e Vérifiez qu’il N’y a rien dans la chambre a rayons X du Path. Icdne Vision sur le bureau

e Le logiciel Vision doit démarrer automatiquement lorsque le
systeme d’exploitation Windows a achevé son démarrage. Si le
logiciel ne démarre pas automatiquement, faites un double clic sur
I'icone Vision présente sur le bureau de Windows.

Etalonnage :

e Au premier démarrage de la journée, le logiciel devrait s’ouvrir sur la page
d’étalonnage.

e Appuyez sur le bouton « Calibrate » (Etalonnage) et patientez jusqu’a ce que le
systéme termine I'étalonnage.

Recommandations supplémentaires pour une qualité d'image cohérente.

Laissez le systéme effectuer un étalonnage complet chaque jour avant la premiére utilisation
du systéme. Le systéme est configuré pour effectuer cet étalonnage lorsque vous démarrez
le logiciel Vision.

Effectuez un étalonnage complet du systeme aprés avoir déplacé le systeme dans une autre
piece pour éviter les difficultés d'imagerie potentielles liées aux différences de température et
d’humidité ambiantes d’une piéce a l'autre.

HOLOGIC
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Faxitron® Path SECTION

Démarrage
Systéme de radiographie d’échantillons rapide
Procédures d’imagerie de base 4.2.0

i o , " . Acquisition
Avertissement : I'utilisation du Path d’'une maniére autre que celle décrite dans ce manuel

ye
peut entrainer un mauvais fonctionnement de I'équipement ou des blessures corporelles. d Images
Avertissement : utilisez des contenants ou des gants agréés afin d’éviter tout contact avec

des échantillons de tissus de patients potentiellement dangereux. 52
Démarrage de la procédure

e Sur la page du menu d’accueil, sélectionnez le bouton Start Procedure (Démarrer

la procédure).
> @ Q)
Review Help Shut Down

e L'utilisateur aura le choix entre Select from Work List (Sélectionner dans la liste de
travail), Manual Entry (Saisie manuelle), Select from Database (Sélectionner dans
la base de données), ou Continue with current patient (Continuer avec le patient
actuel).

Figure 4.1.3
Menu d’accueil du programme
Vision (écran principal)

Start Procedure

Calibrate

e  Pour saisir manuellement une nouvelle procédure, sélectionnez le bouton Manual

Entry (Saisie manuelle).
Figure 4.1.4
< Options de la procédure de
démarrage

EU__I_—Itln,,L.Jf.;Wth current patient el B Sl E

e La boite de dialogue « Patient Information Editor » (Editeur d’informations sur le
patient) s’ouvre.
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Faxitron® Path

SECTION

Démarrage
Systéme de radiographie d’échantillons rapide
4.2.0 Suite
Patient Name: * N Figure 4.1.5

Patient ID: Ll D12
Accession #: t N 123456789

Date of Birth: 1920/03/16

Sex:

Procedure Name:

Laterality:

*

-
V L1

Position View:
Body Part:
Refer. Physician:
Technician:

Technician |D:

Study Name:

Study ID:

Accept

< Start a New Patient or Procedure

Remarque : les champs obligatoires sont indiqués par un
astérisque blanc (*).

Les champs obligatoires par défaut sont : Patient Name (Nom
du patient), Patient ID (ID du patient), Accession Number
(Numéro d’ordre) et Laterality (Latéralité).

e Saisissez tous les champs obligatoires. Le bouton Accept (Accepter) ne sera pas
actif si 'un des champs obligatoires manque. L'utilisateur peut remplir d’autres
champs s'il le souhaite.

Remarque : la date de naissance doit étre saisie au format aaaa/mm/jj (par exemple,
1962/08/13).

e Sélectionnez Accept (Accepter) pour activer I'acquisition d’'images.
Imagerie a Rayons X

¢ Placez le(s) échantillon(s) dans un récipient pour échantillon fourni par Hologic, Inc. ou par
votre établissement et déposez-le(s) a I'intérieur de la chambre a rayons X du Path. La
zone d’imagerie est indiquée par un autocollant matérialisant son contour. (L'utilisateur peut
également placer I'échantillon et le récipient sur le plateau d’agrandissement fourni avec le
systéme Path.)

e Appuyez sur le bouton vert Start X-ray (Démarrer les rayons X) (soit dans le logiciel soit
en face avant de I'armoire a rayons-X) pour démarrer I'acquisition d’images/radiographies.

Ecran des données du patient

A
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Faxitron® Path SECTION

‘ ) s E Démarrage
Systéme de radiographie d’échantillons rapide
¢ Attendez que I'image s’affiche.
Remarque : avec le mode Full Auto sélectionné, deux radiographies seront prises, la .
premiéere pour déterminer les meilleurs réglages et la seconde pour 'image elle-méme. Les 4.2.0 Suite
réglages utilisés pendant I'exposition (kV et durée) sont affichés sur I'écran LCD de
I'armoire.
Le logiciel Vision est configuré pour enregistrer automatiquement I'image dans la base de
données Faxitron sur le disque local de I'ordinateur du systéme. L'utilisateur peut également
enregistrer I'image sur le serveur des installations en cliquant sur I'icbne PACS. Voir
Figure 4.1.6.
faxitron
Figure 4.1.6
Ecran avec image

Pour plus d’'informations sur le réglage des parameétres d'image, les commandes de rayons
X et les options d’analyse et d’enregistrement, voir Section 5.

HOLOGIC
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SECTION 5
Fonctionnement du
logiciel Vision
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION

Logiciel Vision

Le logiciel Vision est un ensemble complet d’acquisition et de traitement d’images, congu
exclusivement pour fonctionner avec les générateurs de rayons X de Faxitron (tels que les
systémes VersaVision, Faxitron Path, CoreVision et BioVision.) En plus des fonctions
d’acquisition et de traitement, le logiciel offre un module de base de données étendue qui
permet a l'utilisateur de commander et de gérer I'archivage, le stockage, le classement et la
récupération des images. Le logiciel est également conforme a la norme DICOM (Digital
Imaging and Communications in Medicine), ce qui permet d’enregistrer et d'imprimer les images
des patients au format DICOM 3.0. Le logiciel a été préinstallé sur I'ordinateur qui était livré
avec votre systéme a rayons X.

L’étalonnage du systéme est requis au début de chaque nouvelle journée d'utilisation du
systéme, pour garantir la meilleure qualité d'image. L'utilisateur du systéme peut également
effectuer un étalonnage a tout moment pour garantir une qualité d’image optimale.

Aprés 'étalonnage, le menu d’accueil s’affiche, ce qui permet de naviguer vers toutes les autres
zones du logiciel. Pour faciliter I'utilisation, des boutons d’application sont disponibles, voir
Figure 5.0.1. Ces boutons se trouvent au centre de I'écran. Les descriptions et définitions des
boutons sont présentées dans les Sections suivantes de ce manuel.

Start Procedure

>

Calibrate Review Shut Down

2007, 14:41:53 Tue

Protocole de séquence

La séquence de démarrage doit étre respectée pour assurer le bon fonctionnement du systeme
et la qualité de I'image.

Mettez I'armoire Faxitron Path sous tension a I'aide de l'interrupteur situé a I'arriére de I'armoire.
(L'interrupteur principal se trouve a coté de la prise du cordon d'alimentation.) Faites basculer
sur « | » pour mettre en position « MARCHE » et sur « 0 » pour mettre en position « ARRET ».

Mettez I'armoire Faxitron Path sur « MARCHE » en insérant la clé Faxitron Path dans
l'interrupteur a clé situé sur le panneau avant et en la tournant dans le sens des aiguilles d’'une
montre jusqu’a la position « 3 heures ». Remarque : la clé ne peut pas étre retirée dans cette
position.

Allumez 'ordinateur et I'écran.

Le logiciel Vision démarre automatiquement lorsque Windows a terminé sa
séquence de démarrage. Une boite de dialogue apparait pour indiquer que
le logiciel a été initialisé et qu’il est en cours de chargement. REMARQUE :
double-cliquez avec le bouton gauche de la souris sur l'icobne Vision
Software (logiciel Vision) (situé sur le bureau de Windows) si Vision ne
démarre pas automatiquement. Voir Figure 5.1.1.

Le logiciel Vision s’ouvrira au menu d’accueil ou a la page d’étalonnage en fonction du temps
écoulé depuis le dernier étalonnage du systeme.

Reportez-vous a la Section 3, « Etalonnage de la caméra », et a la Section 5.2.1, « Apergu de
I'étalonnage de la caméra » pour les protocoles d’étalonnage.

5.0.0
Apercu du logiciel
Vision

Figure 5.0.1
Menu d’accueil du logiciel Vision
(écran de démarrage)

5.1.0
Démarrage du
logiciel

A\

Figure 5.1.1
Icne du bureau du logiciel Vision
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION

Logiciel Vision

Introduction a I’étalonnage

Pour optimiser la qualité de I'image, le logiciel Vision et le matériel nécessitent un étalonnage
périodique. Cet étalonnage nécessite I'acquisition d'images de référence.

Lors de la mise en service initiale du systéme ou a n’'importe quel moment souhaité par
I'utilisateur, un étalonnage du systéme peut étre demandé et effectué. Il est recommandé
d’effectuer les étalonnages suivants toutes les douze (12) heures.

Ces images d’étalonnage de référence sont utilisées pour étalonner une image radiographique
« brute » pixel par pixel, afin de générer une image « corrigée » pour I'affichage. Les corrections
d’'image effectuées comprennent les corrections de gain, de décalage et de linéarité.

Séquence d’étalonnage

Pour plus de commodité, le logiciel Vision combine les nombreuses étapes de I'étalonnage en
une étape unique.

Lorsqu’'un systeme a rayons X Faxitron a été éteint pendant plus de douze (12) heures, le
systéme demande automatiquement a étre réétalonné. Il est fortement recommandé de
réétalonner le systéeme aprés une longue période d’inactivité ou aprés un déplacement du
systeme d’une piéce a une autre, car les paramétres de température/humidité ambiante
peuvent étre différents.

Pour étalonner le systéme & tout moment, cliquez sur le bouton
Calibrate (Etalonner) dans le menu d'accueil de Vision (écran de

démarrage), puis appuyez sur Start Calibration (Démarrer
I'étalonnage). Voir les Figures 5.2.1 et 5.2.2. La boite de dialogue

affiche un message d’état pendant I'étalonnage. Voir Figure 5.2.3.
Calibrate

2007/07/31 14:41:53 Tue

Start Calibration

Last Callbrated: 201 31 14:41:53 Tue

Calibration before beginning any procedure is recommended

Calibrating

LX) SYSTEM IN CALIBRATION

»
a

Pendant I'étalonnage, des rayons X peuvent étre générés. Pendant la génération des rayons
X, un bouton Stop X-Ray (Arréter les rayons X) sera rendu visible pour permettre a I'utilisateur
d’arréter les rayons X par le biais du logiciel.

5.2.0

Apercu de
I’étalonnage de la
caméra

Figure 5.2.1 )
Bouton Calibrate (Etalonner) du
menu d’accueil

Figure 5.2.2
Bouton Start Calibrate (Démarrer
I'étalonnage)

Figure 5.2.3
Etat de I'étalonnage
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Faxitron® Path

Systéme de radiographie d’échantillons

Logiciel Vision

Il peut parfois étre souhaitable d’incorporer les caractéristiques d’atténuation des rayons X d’un
atténuateur uniforme dans les images d’étalonnage de référence en champ plat. Par exemple,
si tous les objets qui doivent étre balayés sont placés sur une mince plaque de plastique, les
caractéristiques d’atténuation des rayons X de la plaque seront observées dans chaque image
acquise. Dans ce cas, le fait de placer la plague dans le faisceau de rayons X pendant
I'acquisition de 'image d’étalonnage de référence en champ plat pourrait améliorer la qualité
de I'image. Voici un résumé du protocole d’étalonnage avancé pour « Both » (Les deux) (champ
plat et image) :

Placez I'atténuateur uniforme sur le détecteur. Toute la surface du détecteur doit étre recouverte
par I'atténuateur. Pour obtenir des résultats optimaux, I'atténuateur doit étre plus grand que la
zone d’imagerie du détecteur.

Depuis I'écran de démarrage du logiciel d’imagerie, appuyez sur l'icone A en haut & droite pour
faire apparaitre le menu. Sélectionnez I'élément du menu déroulant « Tools » (Outils) dans le
menu horizontal situé en haut de I'écran, puis passez de « Advanced Tools » (Outils avancés) a
« X-Ray Calibration/Exposure Setup » (Etalonnage des rayons X/Configuration de I'exposition).

X-ray Generator and Exposure Settings 6

~ GEMERATOR SETTINGS — - EXPOSURE SETTINGS

kW Current mS_ET SetFor  ()Xeray Cal FlatField] (O Manuallmage () Both

Test Exposune User TimesaDU Tanget

md, Curremt | 1000
T A 2.00 ‘Select ) Time @ADL ‘

- 280 .
K -rap Cal Rl |[ERE Time [s] |4_?5 | ADU |snuu.n |
rr:agsnual Acquire E stimate/Calculate

AUTOMATIC EXPOSURE COMTROL [OM THE FLY]

Magrification -| 000
AEC Mode for Image ON [TARGET =Image A0L|

~ NUMBER DF CAL IMAGES ——————— | AEC Mode for Flat-Field DN [TARGET =Flat-Field A0 U]
#-ray Cal [Flat-Field) Averages EI

eEET il bereached by sEES o ut e e stratt

~ IMAGING MODE

Ef-‘qpply Manual Imaging Settings On Exit, Disengage Preshot

[ Accept Settings ] [ Cancel ]

REMARQUE : les valeurs de kV, de temps d’exposition et d’ADU/s peuvent
varier par rapport a celles indiquées.

» Sous « X-Ray Generator and Exposure Settings » (Générateur de rayons X et paramétres
d’exposition), saisissez le réglage en kV du générateur dans le champ approprié.

- Définissez une valeur pour « Magnification » (Agrandissement) ou laissez le réglage par
défaut de un (1.0).

- Sélectionnez le bouton « Set for » (Régler pour) « Both » (Les deux) dans la boite de
dialogue.

- Laissez le réglage par défaut « user ADU target » (cible ADU utilisateur). L’exposition aux
rayons X sera terminée lorsque le détecteur aura accumulé un niveau de signal moyen d’ADU
acceptable pour votre générateur de rayons X.

« Conservez le temps d’exposition par défaut du test et cliquez sur le bouton Acquire
(Acquérir). Le systéeme commencera automatiquement I'émission de rayons X et fera
I'acquisition d’'une image.

- Lorsque I'exposition aux rayons X est achevée, cliquez sur le bouton Estimate/Calculate
(Estimer/Calculer).

« Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]). Le systéme
calcule cette durée et le nombre est grisé.

Etalonnage avancé

Figure 5.2.4
Boite de dialogue Générateur de
rayons X et exposition
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Systéme de radiographie d’échantillons

SECTION
Logiciel Vision

- Saisissez la valeur du temps d’exposition calculé de « Time [s] » (Durée [s]) dans la zone de
temps « Test Exposure » (Exposition test). Appuyez sur le bouton Acquire (Acquérir) pour
lancer automatiquement les rayons X et obtenir une image.

« Lorsque I'exposition aux rayons X est terminée, cliquez sur le bouton Estimate/Calculate
(Estimer/Calculer).

« Enregistrez la valeur du temps d’exposition calculé « Time [s] » (Durée [s]).

- Saisissez a nouveau le temps d’exposition calculé dans le champ « Test Exposure »
(Exposition test).

« Cliquez sur le bouton Accept Settings (Accepter les paramétres).

- Effectuez une procédure d’étalonnage standard, comme décrit dans la Section « Apercu de
I'étalonnage de la caméra ».

Les utilisateurs expérimentés peuvent désirer régler les paramétres d’exposition « X-Ray Cal
(Flat-Field) » (Etalonnage des rayons X [champ plat]) et « Manual Image » (Image manuelle)
indépendamment ou « Both » (Les deux) (champ plat et image manuelle), comme décrit
précédemment. En sélectionnant la case « Flat Field » (Champ plat), le systéme détermine le
temps d’exposition optimal pour I'acquisition d’images en champ plat avec le niveau ADU
souhaité. En conséquence, la sélection de « Manual Image » (Image manuelle) déterminera le
temps d’exposition optimal pour le systéme avec un objet qui atténuera les rayons X. Pour de
meilleurs résultats, toute la zone d’'imagerie du détecteur doit étre recouverte par I'objet.

Aprés avoir sélectionné « X-Ray Cal (Flat-Field) » (Etalonnage des rayons X [champ plat]) et
« Manual Image » (Image manuelle) et une fois le niveau ADU réglé, sélectionnez le bouton
Acquire (Acquérir). Pour la sélection « Manual Image » (Image manuelle), il est souhaitable
que 'objet ou I'atténuateur de rayons X soit dans le faisceau de rayons X. Appuyez sur le bouton
Acquire (Acquérir) pour générer des rayons X et obtenir une image. Lorsque I'exposition aux
rayons X est terminée, cliquez sur le bouton Estimate/Calculate (Estimer/Calculer). Le
systéeme calcule le temps optimal et le nombre est grisé. Cliquez sur le bouton Accept Setting
(Accepter le paramétre) pour enregistrer les « Exposure Settings » (Parameétres d’exposition)
dans le fichier de configuration du systéme. Remarque : seuls les réglages ayant la case
d’option sélectionnée sont enregistrés. Effectuez ensuite une procédure d’étalonnage
standard, comme décrit dans la section « Apercu de I'étalonnage de la caméra ».

Le bouton Start Procedure (Démarrer la procédure) (voir Figure 5.0.1) améne I'utilisateur a la
page Patient Data Entry (Saisie des données du patient), qui propose différents moyens de
saisie des données du patient. Si aucune liste de travail n’a été configurée, I'option sera grisée
et seules les options Continue with current patient (Continuer avec le patient actuel), Manual
Entry (Saisie manuelle) et Select from Database (Sélectionner dans la base de données)
seront accessibles. Les options sont détaillées dans les sections suivantes.

Select from Work List

>

Continue with Current Patient Sl i e E
JANE DOE

5.2.1 Suite

5.3.0

Données du patient

Figure 5.3.1

Ecran de saisie des données du

patient
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION
Logiciel Vision

SELECTIONNER DANS LA LISTE DE TRAVAIL
(liste de travail distante de la modalité)
Si une liste de travail a été configurée, I'utilisateur peut cliquer sur le bouton Select from Work

List (Sélectionner dans la liste de travail) qui affichera la page suivante. Voir Figure 5.3.2
ci-dessous.

Search Parameters: avrsen o00m

hhhhhh
Patient Hame

Patient D

Birth Date

Proc. Start Date 2019/03/28

Accession No.

FAXITRON_DR

— REMARQUE : toutes les données du patient sont
fictives. Toute ressemblance avec des personnes

réelles est strictement fortuite.

Les différents filtres sur la gauche peuvent étre utilisés pour rechercher des procédures
programmeées pour I'entité d’application (AE) de la station de travail. Vérifiez que le titre de 'AE
de la station de travail est défini, puis tout champ unique ou toute combinaison de champs peut
étre utilisé(e) comme filtre pour rechercher des procédures programmeées pour cette AE. En
sélectionnant le bouton Query (Interroger) situé dans le coin inférieur gauche, le tableau est
rempli & nouveau avec les entrées correspondant aux informations recherchées.

L’utilisateur peut alors cliquer sur n’importe quelle entrée puis sur Submit (Soumettre) pour
remplir automatiquement I'éditeur d’informations sur I'imagerie avec les informations du patient.

REMARQUE : I'utilisateur peut également double-cliquer sur n’importe quelle entrée du tableau
pour accéder rapidement a I'éditeur d’informations sur I'imagerie sans avoir a appuyer sur
Submit (Soumettre).

L’éditeur d’informations sur I'imagerie (boite de dialogue d’'informations sur le patient) s’ouvrira.
Voir Figure 5.3.3. Remplissez les autres champs obligatoires et cliquez sur Accept (Accepter)
pour procéder a I'acquisition des images.

5.31
Sélectionner dans
la liste de travail

Figure 5.3.2
Boite de dialogue Rechercher la
liste de travail de la modalité
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Faxitron® Path SECTION

Systéme de radiographie d’échantillons Logiciel Vision

Remarque : les champs obligatoires sont indiqués par un astérisque blanc (*). Les champs 5.3.1 Suite
obligatoires par défaut sont: Patient Name (Nom du patient), Patient ID (ID du patient),
Accession Number (Numéro d’ordre) et Laterality (Latéralité).

L'utilisateur doit compléter tous les champs Figure 5-9-3 ,
requis avant de pouvoir sélectionner le bouton Lf’d/teur dmformatfons sur
Accept  (Accepter).  Lutilisateur — peut IESIVEREEEINS " Rooe | Iimagerie
. . z . . 5 ane
également saisir la date, le médecin traitant, le
nom de la procédure, le sexe, le technicien, la |[BEIELARE *
vue de la position, la partie du corps et I'ID de " .,
I’étude si nécessaire. Le nom de la procédure,
la vue de la position et la partie du corps sont Date of Birth:
choisis via un menu déroulant. e )
Remarque : la date doit étre inscrite dans le
format aaaa/mml/jj (par exemple,
1962/08/13). La non-saisie d'une [GEEEEELEMERIN 0000000 &
date valide peut entrainer des |REFRHRI "
erreurs lors de la récupération
des images. rostionview: | Y
Remarque : les « champs obligatoires »
peuvent étre modifiés ou Refer. Physician: ]
supprimés ,selqn Iappllcatlop. s [ —
Contactez [l'assistance Hologic
pour plus d’informations. Technician ID: ]
Sélectionnez Accept (Accepter) pour continuer
ou Start a New Patient or Procedure RESFSITESE T
(Démarrer un nouveau patient ou une nouvelle
procédure) pour revenir a la page de saisie des  |[WELIALE ]
données du patient.
Start a New Patient or Procedure
Continuer avec le patient actuel 5.3.2

Continuer avec le
Cliquez sur ce bouton pour continuer la procédure du patient actuel. L'« Editeur d’informations patlent actuel

sur 'image » s’ouvrira. Voir Figure 5.3.3. Suivez la procédure et les remarques ci-dessus.

Saisie manuelle 5.3.3
Saisie manuelle

Cliquez sur ce bouton pour saisir manuellement une nouvelle procédure. L’éditeur
d’informations sur I'imagerie s’ouvrira. Voir Figure 5.3.3. Suivez la procédure et les remarques
ci-dessus.
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION
Logiciel Vision

Sélectionner dans la base de données

En choisissant le bouton Select from Database (Sélectionner dans la base de données), la
page suivante s’affiche. Voir Figure 5.3.4 ci-dessous.

PatientID A Las

Search Parameters: 00004 0320-5906 HOUSTON CARLA 2018/04/17 17:35... 1732/04/31

Fatknt IO 00001 AVISET1 KRISTY KAITLYN 1678/03/04
00002 AV3S672 GARCIA MARILA 1678/03/04
Last Name

00003 Av3S673 SMITH MARY 1678/03/04
First Name

Middle Name
Time Modified

Date of Birth

REMARQUE : toutes les données du patient
sont fictives. Toute ressemblance avec des
personnes réelles est strictement fortuite.

I é‘

L’utilisateur sélectionne un patient dans le tableau situé sur le cété droit de la page et clique
ensuite sur le bouton Accept (Accepter) qui ouvre I'éditeur d’informations sur limage.
(Remarque : I'utilisateur peut également double-cliquer sur I'entrée dans le tableau pour ouvrir
I'éditeur d’informations sur I'image) Suivez ensuite la procédure et les remarques de la
page 5-7.

Remarque : utilisez la barre de défilement en bas de I'écran pour afficher les informations
cachées sur le patient.

Vision permet a I'utilisateur de réduire la liste des patients en saisissant des informations
spécifiques dans la fenétre « Search Parameters » (Paramétres de recherche) sur le coté
gauche de la page. Seuls les patients correspondant a tous les paramétres de recherche
s’afficheront.

5.3.4
Sélectionner dans
la base de données

Figure 5.3.4

Sélection du patient a partir des
entrées de la base de données
locale
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Faxitron® Path SECTION

Systéme de radiographie d’échantillons Logiciel Vision

Si l'utilisateur souhaite modifier ou consulter les informations aprés leur saisie, 535

mais avant qu’une image ne soit prise, il peut cliquer sur l'icone Patient Data % ~ -
(Données du patient) dans le coin supérieur gauche. Voir Figure 5.3.5. % Icone (_:le données
du patient

Figure 5.3.5
Icbne de données du patient
La fenétre d’édition des informations sur le patient/I'imagerie s’ouvre. Cette fenétre d’édition
sera complétée avec toutes les informations précédemment saisies/sélectionnées. Voir
Figure 5.3.6. Remarque : la fenétre d’édition comprendra désormais un bouton Cancel
(Annuler).
Figure 5.3.6

Boite de dialogue Image
Properties (Propriétés de l'image)

L'utilisateur peut modifier ou ajouter des
informations a sa guise, puis cliquer sur :

Patient Name:

*

e Le bouton Accept (Accepter) pour
enregistrer les modifications et continuer Patient ID: *

I'acquisition d’images.
Accession #: L 918273
¢ Le bouton Cancel (Annuler) pour annuler les

modifications et continuer I'acquisition
d'images. Le logiciel reviendra aux Sex:
informations initiales saisies sur le patient, ou

Date of Birth: 1920/03/20

e Le bouton Start a New Patient or
Procedure (Démarrer un nouveau patient ou iz b
lfn?. nouvglle' procedurg)_ qui  renvoie Lty
l'utilisateur a I'écran de saisie des données
du patient. Voir Figure 5.3.1. Position View:

Body Part:

* [N

s
s
T
Fomae ¢
I
—
—
(I —
I —
——
T
I—

>

Refer. Physician:
Technician:

Technician ID:

Study Name:

Study ID:

Start a New Patient or Procedure

Une fois que l'utilisateur a cliqué sur le bouton Accept (Accepter), le systeme est prét pour
I'acquisition d’images/de radiographies.

Les rayons X sont générés en appuyant sur le bouton vert Start (Démarrer) situé a I'avant de
I'armoire Faxitron Path ou en cliquant sur le bouton Start X-Ray (Démarrer les rayons X) dans
le coin inférieur droit de I'écran. Voir la Section 4.2.0, Acquisition d’images. Le systéme prendra
une courte radiographie « échantillon », ou pré-photo (explications a la Section 5.4.4) suivie
d’'une exposition plus longue pour acquérir I'image. Le logiciel traitera 'image avant qu’elle ne
soit affichée sur I'écran du moniteur. Une fois I'image affichée, les boutons situés a gauche et
a droite de I'écran, couverts tout au long de cette section, seront activés.

HOLOGIC
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Faxitron® Path

Systéme de radiographie d’échantillons

SECTION
Logiciel Vision

L’utilisateur peut consulter, mais non modifier, les
informations sur le patient aprés avoir acquis une
image en cliquant sur l'icone Patient Data (Données
du patient) de la Figure 5.3.5. Une boite de dialogue
modifiée d’informations sur le patient apparaitra
alors, comme le montre la Figure 5.3.7. Cette boite
comporte deux boutons : Close Dialog (Fermer la
boite de dialogue) ou Start a New Patient or
Procedure (Démarrer un nouveau patient ou une
nouvelle procédure).

Une fois qu’une image est prise, les propriétés de I'image actuelle peuvent étre
visualisées en appuyant sur I'icone (i) dans le coin supérieur droit. Voir Figure 5.3.8.
La boite de dialogue des propriétés de I'image s’affiche dans le coin supérieur droit
de I'image. La boite de dialogue est semi-transparente, pour permettre de voir ce

qui se trouve en dessous. Voir figure 5.3.9.

Patient Name:

Patlent ID:

Accession #:

Date of Birth:

Sex:

Frocedure Name:

Laterality:

Position View:

Body Part:

Refer. Physician:
Technician:

Techniclan |10:

Study Name:
Study 1D:
|

Close Dialog

<

*

L JD458T
Ll 918273

1920/03/20

Start 2 New Patient or Procedure

1.000% 2017/08/14 16:12:18 Monday

8.0 kY, 1.00 mA,

3.73 mAs, 3.73s,

120170814161218.dom

C:\Bioptics\Datal

Faxitron Bioptics

5.3.5 Suite

Figure 5.3.7

Boite de dialogue Patient
Information (Informations sur le
patient) apres I'acquisition
d’images

Figure 5.3.8
Icéne de propriétés de l'image

Figure 5.3.9

Boite de dialogue Image
Properties (Propriétés de I'image)
(visualisation uniquement)
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Faxitron® Path

Systéme de radiographie d’échantillons

Logiciel Vision

Le logiciel Vision fournit divers outils et menus pour contréler divers attributs ou parameétres
d’'image, 'acquisition de rayons X, les vues d’image, les outils d'image et les paramétres/accés
DICOM. Les outils les plus couramment utilisés se trouvent dans une barre d’outils. La barre
d’outils et les menus sont décrits plus en détail dans les pages suivantes.

Le logiciel Vision permet d’accéder d’'un seul clic a un certain nombre d’outils ou de fonctions
couramment utilisés grace a une barre d’outils verticale située sur le c6té gauche de I'écran.
Des descriptions plus détaillées suivent dans les pages suivantes. Voir Figure 5.4.1.

Afficher/modifier les informations REMARQUES :
sur le patient
(Voir Section 6.3.5 et Figure 6.3.5) Les outils suivants sont toujours
actifs dans la page d’acquisition
. . . d'images :
Icone Améliorer I'image o Afficher/modifier les informations

sur le patient.
e Controle de I'exposition.
o Retour au menu principal, et
Outil de niveau de la fenétre et o Arrét du systéme.
de contraste
Les outils suivants seront désactivés
apres la saisie des données du

Outil de zoom numérique patient et ne seront activés qu’aprées
I'acquisition d’une image
radiographique :

o Améliorer 'image.
Outils d’annotation ¢ Niveau de la fenétre et contraste.

e Zoom numeérique, et
e Annotation.

Les outils d’enregistrement PACS et
d’'impression PACS ne sont activés
qu’aprés I'acquisition d’'une image
radiographique et lorsque le systéeme
est connecté a un réseau PACS.

Enregistrement PACS

Impression PACS

Controle de I’exposition
(panneau de commande du dispositif)

Retour au menu principal

Arrét du systéeme

Barre d’outils et
menus

Barre d’outils
latérale

Figure 5.4.1
Barre d'outils latérale
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Faxitron® Path

Systéme de radiographie d’échantillons

Logiciel Vision

Améliorer I'image

Le bouton présenté a la Figure 5.4.2 traite I'image sur I'écran pour mettre en valeur les détails
plus petits, tels que les micro-calcifications et les petites masses dans I'image.

/4(

L’algorithme, communément appelé « Peripheral Equalization » (Egalisation périphérique) ou
« Thickness Equalization » (Egalisation d’épaisseur) en imagerie avancée, est appliqué a
'ensemble de I'image. En plus de cet algorithme, Hologic utilise un deuxiéme algorithme
développé en interne appelé « Calcification Emphasis » (Accentuation de la calcification). Cet
algorithme secondaire a été congu pour faire ressortir les petits détails de I'image et les rendre
beaucoup plus faciles a voir et a analyser.

Comme les images des patients constituent une catégorie plus générale pour les géométries
et les différentes épaisseurs possibles, certains échantillons peuvent avoir des géométries
délicates et I'utilisateur doit utiliser cet outil avec précaution.

Le systéme sera inactif (en veille) pendant le traitement. Une fois terminé, le bouton restera
enfoncé/actif. L'utilisateur peut annuler le processus en appuyant & nouveau sur le bouton.

Figure 5.4.2
Icéne d’amélioration de I'image
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Faxitron® Path SECTION

Systéme de radiographie d’échantillons Logiciel Vision

Réglage de I'inversion, du niveau de la fenétre et du contraste 5.4.1 Suite

Le bouton, illustré a la Figure 5.4.3, ouvre l'outil de réglage du niveau de la fenétre et du
contraste. Cet outil permet a I'utilisateur d’ajuster le niveau de la fenétre et le contraste de
'image. L'utilisateur peut également restaurer le contraste d’origine en appuyant sur le bouton
Original Contrast (Contraste d’origine), ou inverser I'image, en appuyant sur le bouton Invert
(Inverser). Linversion fait passer le schéma de couleurs d’'une prédominance de noir a une
prédominance de blanc et inversement. Voir Figure 5.4.4 ci-dessous.

Figure 5.4.3

Icéne et commandes de l'outil de
niveau de la fenétre et de
contraste

L'utilisateur peut également régler le curseur pour le
contraste d'image désiré en cliquant sur le curseur
et en le déplagant vers le haut et vers le bas ou en
cliguant sur l'une des fléches indiquées sur le
curseur pour déplacer les limites inférieures ou
supérieures du niveau de la fenétre. Voir
Figure 5.4.3 (officieusement, ceci est également
connu sous le nom de « Window Leveling » (Mise a
niveau de la fenétre)).

Q

1650

Original Contrast

Invert

Un exemple d’inversion est présenté ci-dessous : Figure 5.4.4

Exemple d’inversion avec
l'outil de réglage du contraste et
niveau de la fenétre
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Faxitron® Path

Systéme de radiographie d’échantillons

Logiciel Vision

Réglage dynamique du zoom

L’icone de I'outil de zoom, Figure 5.4.5, ouvrira I'outil de réglage du zoom. Aprés avoir ouvert
cet outil, I'utilisateur peut utiliser la barre de défilement pour ajuster le niveau de zoom ou cliquer
sur les boutons Fit to Specimen (Ajuster a I'échantillon), Fit to screen (Ajuster a I'écran) ou
Zoom 1.0x (Zoom x1,0) (pleine résolution). Voir Figure 5.4.6. Lorsqu’'un zoom a été effectué
sur 'image, un panoramique est nécessaire pour naviguer dans I'image. Une boite de dialogue
sous forme de vignettes apparaitra dans le coin supérieur gauche de I'écran, voir la Figure 5.4.7
ci-dessous. Cliquez sur le bouton gauche sur 'image et maintenez-le enfoncé, puis déplacez
la souris pour déplacer I'image dans I'écran principal.

Notez que traditionnellement, cette fonction est aussi appelée « Pan View » (Panoramique)
et/ou « Pan and Scan » (Panoramique et balayage).

ZOOM LEVEL *
—  3.00x
—  1.00x
—  010x
Le bouton Fit to Specimen (Ajuster a I'échantillon) tente de 0.44
détecter et de zoomer sur I'échantillon afin de s'assurer qU'il est e —
entierement visible. Si aucun échantillon n’est détecté, il
reviendra par défaut au mode précédent (soit « Fit to Screen »
(Ajuster a I'écran) ou « Zoom 1.0x » (Zoom x1,0)). | |
L’option Fit to screen (Ajuster a I'écran) ajuste I'image aI’écran.
[
Le Zoom 1.0x (Zoom x1,0) est traditionnellement appelé « Full
Resolution » (Pleine résolution) car il offre une vue de I'image a
la taille 1-1 avec la résolution du moniteur.
Cancel oK

Figure 5.4.5
Icéne d’outil de zoom

Figure 5.4.6
Outil de réglage du niveau de
zoom

Figure 5.4.7
Exemple de vue panoramique
(a gauche)
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Systéme de radiographie d’échantillons

SECTION
Logiciel Vision

Annotation

Le bouton présenté sur la Figure 5.4.8 ouvre les outils d’annotation. Ces outils et leurs
nombreuses options sont présentés plus en détail a la section 5.8.0.

Enregistrement PACS

Le bouton présenté a la Figure 5.4.9 fonctionne uniquement lorsque le systeme est
installé dans un établissement médical doté d’'un réseau PACS. Pour enregistrer
vos fichiers localement, reportez-vous a la Section 5.7.0.

0 E

Impression PACS

Le bouton présenté a la Figure 5.4.10 fonctionne uniquement lorsque le systeme est
installé dans un établissement médical doté d'un réseau PACS. Pour une
impression locale, reportez-vous a la Section 5.7.0.

Panneau de commande du dispositif

Le bouton présenté a la Figure 5.4.11 ouvre le panneau de commande du dispositif,
qui permet a l'utilisateur du dispositif de commander facilement le systéeme de
radiographie par le biais du logiciel. L'utilisateur peut facilement sélectionner le
mode d’exposition, le réglage des kV du tube a rayons X, le temps d’exposition et
le nombre d'images a acquérir pour le calcul de la moyenne des images (si désiré)
ainsi que lancer I'exposition aux rayons X.

REMARQUE : [l'état ou la disponibilité des
parameétres d’exposition est indiqué par les fleches
haut/bas adjacentes au parametre. Les fleches
seront blanches pour les paramétres actifs et bleu
clair pour les parametres inactifs. Les parametres
d’exposition qui sont actifs dépendent du mode
d’exposition sélectionné.

@ Full Auto
() Auto Time

O Auto kV
O Full Manual

La Figure 5.4.12 & droite montre que le mode
entierement automatique a été sélectionné et que
les moyennes kV, temps et image sont toutes
actives. L'utilisateur peut ajuster chacun de ces
parameétres.

26
3.00
0.40

Time (s)

Notez que le paramétre mA dans le systéme

Faxitron Path n’est pas réglable par le logiciel. Les

parameétres mA seront affichés comme inactifs.
N

Image Averages AV 4

Lorsque vous avez terminé, cliquez sur le bouton
Request X-Rays (Demande de rayons X) pour
acquérir une image, ou sur le bouton Set (Régler)
pour enregistrer les parametres et fermer le
panneau de commande du dispositif.

Reguest X-Rays

< Cancel
Si vous cliquez sur le bouton Cancel (Annuler), le
panneau de commande du dispositif se fermera sans enregistrer les modifications.

5.4.1 Suite

Figure 5.4.8
Icéne d’annotations

Figure 5.4.9
Icéne d’enregistrement
PACS

Figure 5.4.10
Icéne d’impression PACS

Figure 5.4.11
Icbne de retour a la procédure

Figure 5.4.12
Panneau de commande du
dispositif
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Systéme de radiographie d’échantillons

Logiciel Vision

Retour a la procédure

Le bouton présenté a la Figure 5.4.13 permet de quitter le mode d’acquisition d'image

et de revenir a I'’écran du Menu Principal. <
Arrét

Le bouton, illustré a la Figure 5.4.14, permet de quitter le logiciel et d’éteindre le

systeme. |

Remarques supplémentaires concernant les boites de dialogue

Lorsqu’une boite de dialogue est ouverte, elle est « ancrée » a gauche de I'écran. Si un
utilisateur souhaite désolidariser la boite de dialogue, il peut cliquer sur l'icéne « Epingle » en
haut a droite pour désolidariser la boite de dialogue et pouvoir la faire glisser librement.
L’épingle se transforme alors en ic6ne « X » permettant une fermeture rapide.

L’utilisateur peut également naviguer rapidement entre les différentes boites de dialogue en
cliquant sur le menu de gauche. Ce faisant, le menu de gauche se ferme rapidement et ouvre
les boites de dialogue appropriées.

Barre de menu supérieure

Le logiciel permet d’accéder aux menus « View » (Affichage), « Tools » (Outils), « Image
Tools » (Outils image), « DICOM Ultilities » (Utilitaires DICOM) et « Help » (Aide) via une barre
de menu supérieure. Voir Figure 5.4.15. La barre de menu supérieure est masquée par défaut
et s’affiche en cliquant sur le bouton Fléche dans le coin supérieur droit de I'écran. Voir
Figure 5.4.16. Le bouton Fléche est noir ou blanc selon la page du logiciel ou le fond d’écran.
Chaque élément du menu est traité en détail dans les pages suivantes.

File Edit View Tools Image Tools DICOM Utilities Help

v M

Remarque : la fleche pointe vers le bas lorsque le menu supérieur est
masqué et pointe vers le haut lorsqu’il est affiché.

Menu View (Affichage)

Le menu « View » (Affichage) est situé dans le menu principal supérieur et contient les éléments
de sous-menu indiqués dans la Figure 5.4.17 ci-dessous. Chaque élément de sous-menu sera
décrit plus en détail dans les pages suivantes.

mTools Image Tools  DICOM Utilities Help

Zoom Mode L NORMAL (FULL RES.)

Image Averages ADJUST ZOOM
Image Perspective FIT TO SAMPLE
Grid Options v | FTALL

User Window Levels FIT WIDTH
Default Window Level FIT HEIGHT

Default Aspect for Raw Files
| Enhanced Image
Sample Viewer

Magnifier Size

* v ¥ ¥ v wv wv v v v

Review Layout

Figure 5.4.13
Icéne de retour au menu d’accueil

Figure 5.4.14
Icéne d’arrét du systeme

Barre de menu
supérieure

Figure 5.4.15
Barre de menu supérieure

Figure 5.4.16
Boutons de la barre de menu
supérieure

Menu Affichage

Figure 5.4.17
Menu View (Affichage)
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SECTION
Logiciel Vision

Zoom Mode (Mode Zoom)

Normal (Normal)

Affiche I'image acquise dans son format d’origine. L'image dans les systémes Faxitron Path
dépasse la zone d’affichage des moniteurs. Une boite de dialogue de vignettes s’affiche dans
le coin supérieur gauche de I'image et permet a I'utilisateur de « faire un panoramique » de
I'image. Reportez-vous au réglage dynamique du zoom a la Section 5.4.1.

Adjust Zoom (Régler le zoom)

Cette option est grisée et n’est pas disponible pour le moment.

Fit to Sample (Ajuster a I’échantillon)

Cette option permet d’ajuster I'image acquise pour qu’elle corresponde au mieux a I'échantillon
dans la zone d’affichage du moniteur.

Fit All (Ajuster tout)

Cette option affiche 'ensemble de 'image acquise, quel que soit son format d’origine. L’option
Full Resolution (Pleine résolution) ne fonctionne pas dans ce mode d’affichage.

Fit Width (Ajuster la largeur)

Cette option permet d’afficher I'image acquise sur toute la largeur disponible de la zone
d’affichage.

Fit Height (Ajuster la hauteur)

Cette option permet d’afficher I'image acquise sur toute la hauteur disponible de la zone
d’affichage.

Image Averages (Moyennes des images)

Cette option permet a I'utilisateur de régler le nombre de moyennes d’images a prendre par
exposition. Les options disponibles sont les suivantes : prises de vue x1, x2, x4 ou x8. Le
réglage par défaut est le suivant : prises de vue x1. Si l'utilisateur sélectionne 2, 4 ou 8 prises
de vue, le logiciel acquiert le nombre d’'images sélectionnées dos a dos par une simple pression
sur le bouton Start (Démarrer) et fait la moyenne de ces images en une seule.

Image Perspective (Perspective d’image)

Cette option permet a l'utilisateur de faire pivoter 'image affichée de 0, 90, 180 et 270 degrés
pour l'orienter.

5.4.3 Suite
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Logiciel Vision

Grid Options (Options de grille)

Lorsqu’une image est affichée, que ce soit une image acquise ou une image récupérée dans la
base de données, I'utilisateur peut activer une grille. Elle permet également a I'utilisateur de
régler 'espacement de la grille (pas). Voir 'exemple ci-dessous.

User Window Levels (Niveaux de la fenétre utilisateur)

Ceci permet a I'utilisateur de définir jusqu’a trois (3) niveaux de fenétre (WL) prédéfinis et définis
par l'utilisateur. Sélectionnez d’abord le bouton Window Level (Niveau de fenétre). Réglez le
niveau de fenétre (WL) sur le niveau souhaité. Dans les outils « View » (Affichage), sélectionnez
« User Window Levels » (Niveaux de fenétre utilisateur). Sélectionnez « Record Current WL as
USER WL #1, #2 or #3 » (Enregistrer le WL actuel en tant que WL UTILISATEUR N°1, N°2 ou
N°3). Le WL réglé sera enregistré sous le choix précédemment sélectionné.

Default Window Level (Niveau de fenétre par défaut)

L’utilisateur a le choix entre deux niveaux « Default Window Levels [WL] » (Niveaux de fenétre
[WL] par défaut). « Optimize for whole area » (Optimiser la zone entiére), qui ajuste le WL pour
'image entiére, ou « Optimize for sample » (Optimiser pour I’échantillon), qui ajuste le WL pour
la zone sous I'échantillon uniquement. De plus, il existe une option permettant de définir le
« Default Window Level » (Niveau de fenétre par défaut) qui est utilisé pour toutes les images
obtenues, situées ici aussi. Ceci définira le niveau de fenétre par défaut basé sur les statistiques
de lI'image ; cette action devra étre effectuée séparément pour les images non améliorées et
améliorées.

Default Aspect of Raw Files
(Aspect par défaut des fichiers bruts)

Cet outil est disponible sous le menu VIEW (AFFICHAGE). Il permet d'importer/ouvrir des
fichiers d'images précédemment enregistrés avec des attributs de fichiers inconnus ou des
données d’images binaires sans aucune information d’en-téte. Comme la taille exacte du
tableau de I'imageur n’est pas disponible dans I'en-téte du fichier de données d’image, on
utilisera les dimensions de I'imageur les plus proches pour importer/ouvrir ces images, en se
basant sur le fait que la largeur est supérieure ou inférieure a la hauteur (informations d’aspect
par défaut).

Figure 5.4.18
Affichage de la grille
d’échantillonnage
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Enhance Image (Améliorer I'image),
identique au bouton du méme nom

Traite I'image actuelle du patient et améliore la visualisation des tissus situés prés de la
périphérie de I'échantillon.

Sample Viewer (Affichage d’échantillon)

Si le systéme est équipé d’'une caméra Web, celle-ci active la visionneuse de caméra Web du
systéme pour permettre I'orientation et I'alignement de I'échantillon.

Review Layout (Mise en page de la révision)

Aide l'utilisateur a configurer plusieurs volets d'image en mode Review (Révision) (base de
données) du programme. Les options disponibles sont les suivantes ; mise en page « (1 X 1)
Single » (Simple [1 X 1]), « (2X 1) Double H » (Double H [2 X 1]), « (1 X 2) Double V » (Double
V[1X2]), «(1+ (2X1) Triple » (Triple [1 + (2 X 1)]) et « (2 X 2) Quadruple » (Quadruple
[2 X 2]). Pendant les opérations sur plusieurs volets, I'utilisateur peut cliquer une fois sur le
volet/image désiré(e) pour en faire la sélection courante ; la bordure rectangulaire du volet
sélectionné deviendra verte. Les images dans la vue Liste de base de données ou dans la vue
Vignettes de la base de données seront ouvertes dans le panneau sélectionné a l'aide d’'un
double-clic. L'utilisateur peut également ouvrir les images dans les volets souhaités directement
a partir du menu contextuel (clic droit) des vues de la base de données mentionnées. Apres
avoir activé le menu contextuel a I'aide d’un clic droit, 'utilisateur peut choisir parmi les volets
listés sous OPEN TO- (OUVRIR DANS) qui lui fourniront les volets disponibles pour ouvrir
'image (gauche, droite, haut, bas, etc.).

Menu Outils

Le menu « Tools » (Outils) est situé dans la barre de menu supérieure qui se trouve dans le
coin supérieur gauche de I'écran principal.

REGD Image Took  DICOM Lhilities  Help

Preferences

Geraice Maode

Advanced Tools ¥ AUTO SAVE OBAOFF k

PROPERTIES EDGE SUPRRESSION "
TILE SUPPRESSION 3

KBAY Cabbestion Exposure Setup
FRESHOT AEC Expodure ebup
IMAGE EMHAMCEMEMT Setuvp

DELETE Cumrent lnage Recoed
ADD  Cumrent lnage Recoed

CAPTURE Screen Shot IPG/EMP

Login Lriley
SavelSicee current mage ] Cyl Auidomuted Acguiitssng
Prind crent image ¥ OTHER ADVANCED Lher Teck »

Preferences (Préférences)

Le menu « Preferences » (Préférences) ouvre un utilitaire de gestion de la configuration qui
peut étre utilisé pour modifier diverses options ou paramétres.

REMARQUE : 'option de l'outil « Preference » (Préférence) est protégée par mot de passe et
ne doit étre accessible qu’a un représentant de service Hologic autorisé.

REMARQUE : la modification des paramétres de configuration sans connaissance ou
autorisation appropriée peut entrainer une perte de qualité d'image, des dommages au systéeme
et un dysfonctionnement de ce dernier.

Menu Outils

Figure 5.4.19

Menu Outils
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Service Mode (Mode entretien)

Le « Service Mode » (Mode entretien) est protégé par mot de passe et est activé par les
techniciens autorisés de Hologic a des fins de dépannage.

Service Tools (Outils d’entretien)

L’option « Service Tools » (Outils d’entretien) est normalement grisée. Elle n’est activée que
lorsque le systéme est en « Service Mode » (Mode entretien).

Save Reference Files (Enregistrer les fichiers de référence)

L’'option « Save Reference Files » (Enregistrer les fichiers de référence) est normalement
grisée. Elle n’est activée que lorsque le systeme est en « Service Mode » (Mode entretien).

Options du menu Advanced Tools (Outils avancés)

Le menu Advanced Tools (Outils avancés) propose diverses options pour configurer des
aspects du logiciel tels que le post-traitement et les options de configuration.

Auto Save On/Off (Enregistrement automatique Marche/Arrét)

Lorsque l'option « Auto Save » (Enregistrement automatique) est activée, toutes les images
acquises ultérieurement sont enregistrées dans la base de données. Les fichiers sont
enregistrés dans une donnée directement définie dans le fichier de configuration.

X-Ray Calibration/Exposure Set-up (Etalonnage des rayons
X/Configuration de I’exposition)

Cet outil se trouve dans Advanced tools (Outils avancés). L'option « X-Ray
Calibration/Exposure Set-up » (Etalonnage des rayons X/Configuration de I'exposition) aide
I'utilisateur a déterminer le temps d’exposition approprié pour un réglage kV sélectionné afin
d’obtenir une meilleure qualité d’image. Veuillez vous reporter a la Section 5.2.0 et a la
Figure 5.2.1 pour une description plus détaillée.

Preshot AEC Exposure Setup
(Configuration de la pré-photo de I’exposition de ’AEC)

Le systéme Faxitron Path utilise le controle automatique de I'exposition (AEC) pour fournir la
meilleure qualité d'image possible par une simple pression sur le bouton Start X-Ray (Démarrer
les rayons X). Le logiciel utilise une exposition Preshot (Pré-photo) pour calculer I'exposition
optimale en kV et les paramétres de temps. La Preshot (Pré-photo) est une exposition courte,
généralement de 2 a 3 secondes, aux rayons X. Le logiciel analyse les résultats pour déterminer
le kV et le temps nécessaires pour produire la meilleure qualité d’image. La pré-photo de
I'exposition de 'AEC est configurée a 'usine et est activée par défaut.

« Preshot AEC Exposure Setup » (Configuration de la pré-photo de I'exposition de I'AEC)
permet a l'utilisateur d’ajuster le systéme pour des besoins d’imagerie particuliers ou pour
compenser le vieillissement du systeme.

Pour accéder a la boite de dialogue « Preshot AEC Exposure Setup » (Configuration de la pré-
photo de I'exposition de 'AEC), allez dans la barre de menu supérieure, sélectionnez « Tools »
(Outils), « Advanced Tools » (Outils avancés) puis « PRESHOT AEC Exposure Setup »
(Configuration de la PRE-PHOTO de I'exposition de 'AEC). Voir Figure 5.4.19.

5.4.4 Suite
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Saisissez les valeurs d’AEC pour la
PRE-PHOTO dans la fenétre de
droite.

Les parametres indiqués refletent un
temps d’exposition de 26 kV et de
3 secondes avec une intensité cible
de 10 000 ADU pour le paramétre de
pré-photo. Les utilisateurs peuvent

entrer dans la sélection des
parameétres de pré-photo
uniquement en sélectionnant

DYNAMIC METHOD (METHODE
DYNAMIQUE) dans la section
ANALYSIS METHOD (METHODE
D’ANALYSE). La sélection de
STATIC METHOD (METHODE
STATIQUE) utilise les paramétres
prédéfinis du Faxitron. De plus,
lutilisateur a la possibilit¢ de
sélectionner les réglages de kV et de
temps d’exposition dans la section
EXPOSURE TUNING METHOD
(METHODE DE SYNTONISATION
DE L’'EXPOSITION).

Pour des images plus précises,
I'utilisateur peut saisir I'épaisseur du
TISSU MOU (échantillon) et
FINTENSITE CIBLE dans les ADU.
REMARQUE : les valeurs indiquées
dans limage ci-dessus sont
uniquement un exemple. La valeur
correcte doit étre déterminée.

PRESHOT - AEC ON/OFF

PRESHOT AMALYSIS METHOD

DYNAMIC METHOD
% [Acquire Preshot Image Before Every Imane, Analyze and
Ture Settings)

¥ TURM OM PRESHOT - AEC

I
DYNAMIC PRESHOT PREFERENCES
PRESHOT ki DESIRED [kV] 260

PRESHOT TIME DESIRED [s] 2.00

PRESHOT COMBINATION |[1]NDNE,DISEAHD PRESHOT, SHOW AEC SHOT ALONE j

230

E72
oo F

EXPOSURE TUNING METHOD
& AUTO RV AUTOTIME  © AUTO KV / FIXED TIME

7.30 45.0

THICKNESS/BEAM HARDENING /OVEREURN

@ AUTODETECT SAMPLE THICKNESS
FROM PRESHOT/PRELOADED IMAGE

" FIXED k¥ / AUTO TIME

¥ ENABLE OVERBURM PROTECTION

ENTER SOFT TISSUE EQUIVALENT = * Preshot and AEC shat are
SAMPLE+TRAY THICKMESS [0] 0.00"=0.00cm assumed ta have similar

samplettray thicknesses

TARGET INTENSITY
*GENERAL RECOMMENDATION: Use

ENTER DESIRED MEAN B0-90% of Mean Flat Field Value Fi
INTENSITY LINDER SAMPLE [apl)  |'00000 B e e ]

oo

Remarque : les valeurs dans I'image ci-dessus sont typiques du systéme Faxitron Path. Les
valeurs exactes de votre systeme doivent étre déterminées.

Pour

le mode AUTOMATIC EXPOSURE CONTROL (COMMANDE D’EXPOSITION

AUTOMATIQUE), appuyez sur le bouton Start (Démarrer) du logiciel Vision (ou sur le panneau
de commande). Le logiciel Vision effectue une pré-photo (courte, a faible dose, pré-exposition)
de I'échantillon pour créer une région d’'intérét (ROI) afin d’obtenir les paramétres d’exposition
permettant d’obtenir une exposition optimale de I'image.

Figure 5.4.20

Boite de dialogue de
configuration de la pré-photo de
I'exposition de 'AEC
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Utilitaire de connexion 5.4.4 Suite

L’utilitaire de connexion se trouve dans le menu ADVANCED TOOLS (Outil avancés) et permet
a l'utilisateur de configurer et d’activer I'authentification par mot de passe de démarrage pour
le logiciel Vision. L’activation de cette fonction est facultative sur le systéme Faxitron Path. Si
I'utilisateur active I'authentification par mot de passe, il sera invité a saisir le mot de passe a
chaque ouverture du programme. Le programme se fermera si le mot de passe correct n'est
pas saisi.
Figure 5.4.21

Utilitaire de connexion.

Le méme écran s’affiche
Current Passwarct lors de l'authentification au
démarrage.

NEW FASSWORD |
CHANGE

PASSWORD: RE-ENTER MEW |

PASSWORD

AUTHENTICATE

OPTION: ¥ Enforce User Authentication on Software Startup

Apply Changes

Properties (Propriétés)
L’option « Properties » (Propriétés) masque ou affiche la boite d’informations sur 'image. Voir
Figure 5.3.9.
Edit Current Image Record (Modifier le dossier d’image actuelle)

Actuellement non utilisé.

Delete Current Image Record
(Supprimer le dossier d’image actuelle)
Supprime 'image actuelle du répertoire de fichiers comme spécifié dans le fichier de
configuration.

Add Current Image Record
(Ajouter un dossier d’image actuelle)

Ajoute I'image actuelle au répertoire de fichiers comme spécifié dans le fichier de
configuration.

Capture Screen Shot JPG/BMP (Capture d’écran JPG/BMP)

En sélectionnant ce choix dans le menu, I'utilisateur peut faire une capture d’écran de la
fenétre active affichée. L'utilisateur peut spécifier un nom de fichier et choisir entre les formats
JPG et BMP pour enregistrer le fichier.

Save / Store Current Image (Enregistrer/Stocker I'image actuelle)

L’utilisateur peut « naviguer » vers le répertoire ou le dossier de fichiers dans lequel 'image
doit étre enregistrée. Un nom de fichier doit étre attribué dans le champ prévu a cet effet.
Sélectionnez un type de fichier pour I'option Enregistrer 'image sous. De nombreux types de
fichiers sont disponibles. Pour enregistrer le fichier dans un format DICOM, reportez-vous a la
section « Fonctionnalité DICOM ».

Print Current Image (Imprimer I'image actuelle)

Imprime I'image actuelle sur 'imprimante WINDOWS.
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Outils image

Les fonctions suivantes sont disponibles pour modifier I'image acquise ou récupérée en
cliquant sur le menu « Image Tools » (Outils image). Voir Figure 5.4.22. Les options du sous-
menu sont activées ou accessibles par un simple clic sur I'option souhaitée.

=GN DICOM Liilities

Original Contrast

Invert

Magnifier
Enhance

ROI Contrast

ROI Window Level
Ruler

ROI Statistics

ROI Histogram
ROI Profile

Line Profile

Original Contrast (Contraste d’origine)

L’option « Original Contrast » (Contraste d’origine) rétablit les niveaux de contraste de I'image.
Elle a le méme objectif que le bouton Original Contrast (Contraste d’origine) dans I'outil de
niveau de la fenétre et de contraste. Voir Section 5.4.1 et Figure 5.4.3.

Invert (Inverser)

L’option « Invert » (Inverser) provoque linversion ou le renversement de l'image affichée.
L’inversion d’une image inverse sa transparence : ce qui est noir devient blanc et ce qui est
blanc devient noir. Les gris se voient attribuer leur transparence « miroir ». Cliquez a nouveau
sur « Invert » (Inverser) pour désactiver la fonction. Exécute la méme fonction que le bouton
Invert (Inverser). Reportez-vous a la Section 5.4.1 et aux Figures 5.4.3 et 5.4.4.

Outils image

Figure 5.4.22
Menu Image Tools (Outils image)
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Magnify (Agrandir)

L’option « Magnify » (Agrandir) permet a I'utilisateur d’agrandir une zone d’intérét. Pour utiliser
la fonction Magnify (Agrandir), placez le curseur de la souris sur la zone a agrandir et faites un
clic gauche. La zone d’'intérét sera agrandie. Cliquez a nouveau sur « Magnify » (Agrandir) pour
désactiver la fonction. Reportez-vous a la Figure 5.4.23. La taille de la zone d’intérét agrandie
peut étre ajustée par I'utilisateur. Reportez-vous au sous-menu « Magnifier Size » (Taille de la
loupe) de la Section 5.4.3.

Edge Enhance (Amélioration des contours)

L’option « Edge Enhance » (Amélioration des contours) crée une définition plus nette autour
des contours des régions présentant une différence de contraste. D’'une maniére générale,
I'amélioration des contours peut amplifier le bruit des images. En sélectionnant a nouveau cet
élément dans le menu, vous désactivez 'amélioration des contours. Cliquer sur « Original
Contrast » (Contraste d’origine) permet également de rétablir I'image dans son état d’origine.
Notez qu'il s’agit d’'une fonction différente de I'option Enhance Image (Améliorer 'image) décrite
aux Sections 5.4.1 et 5.4.3.

Contraste de la ROI

L’option « ROl Contrast » (Contraste de la ROI) permet d’optimiser les niveaux de contraste
dans une région d’intérét (ROI) définie par I'utilisateur. Apres avoir sélectionné « RO/ Contrast »
(Contraste de la ROI), cliquez et maintenez le bouton gauche de la souris au point de départ
de la ROI désirée, faites glisser la souris et relachez le bouton de la souris au point final de la
ROI désirée. Le contraste se régle automatiquement sur les meilleurs niveaux pour cette ROL.
(Voir la Section Définitions pour la ROI)

ROI Window Level (Niveau de fenétre de la ROI)

La fonction « ROl Window Level » (Niveau de fenétre de la ROI) n’est pas disponible dans la
version actuelle du logiciel Vision.

Figure 5.4.23
Magnify (Agrandlir)
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Ruler (Regle)

L’option « Ruler » (Regle) permet a l'utilisateur de mesurer la distance entre deux points de
'image affichée. Les mesures de longueur sont en millimétres (mm). Aprés avoir sélectionné
« Ruler » (Regle), cliquez et maintenez le bouton gauche de la souris enfoncé en commencant
par le point de mesure, faites glisser la souris et relachez le bouton de la souris au point de
mesure final. La régle est affichée sous la forme d’une ligne rouge sur I'image.

La mesure (en mm) s’affiche a
I'extrémité de la regle. La régle
reste active jusqu'a ce que
I'utilisateur sélectionne un autre
outil d'image ou jusqu’'a ce qu’'une
autre action soit effectuée. Voir
Figure 5.4.24 & droite. Cliquez a
nouveau sur « Ruler» (Regle)
pour désactiver la fonction.

Astuce : pour obtenir une ligne
parfaitement droite ou une ligne a
un angle parfait de 45 degrés,
maintenez la touche SHIFT
enfoncée (sur le clavier) tout en
maintenant le bouton gauche de la
souris enfoncé en la faisant glisser.

ROI Statistics (Statistiques de la ROI)

« ROI Statistics » (Statistiques de la ROIl) affichera une boite de dialogue contenant des
statistiques sur les images. Cliquez et maintenez le bouton gauche de la souris enfoncé sur la
région d’intérét (ROI) de I'image principale, faites glisser le curseur pour faire une sélection
autour de la zone, puis relachez le bouton de la souris. Les informations statistiques pour la
région sélectionnée s’afficheront sur le coté gauche de la boite de dialogue et pour I'image
entiere sur le cété droit de la boite. Les statistiques affichées sont les suivantes : les points de
début et de fin de la ROI, les valeurs d’intensité minimale, maximale et moyenne, et I'écart type
(STD). Pour fermer la boite d’information Statistics (Statistiques), il suffit de cliquer sur le bouton
Close (Fermer). Voir Figure 5.4.25. Cliquez a nouveau sur « RO/ Statistics » (Statistiques de
la ROI) pour désactiver la fonction.

Selected Region Wwhole Image

[T op Left)=[583.1383) [Top.Left)=(0.0]
[Baottorn,Right)=[1183,2558) [Buottom.Right)=[3072,3833]

Minimnurm: 516 Minirnurn: 523

M awirnurn: 7537 M arimurm: 14042
Mear:5620.00 Mear:3606.26
STO: 955.60 STO:4026.28

Figure 5.4.24
Ruler (Regle)

Figure 5.4.25
ROI Statistics (Statistiques de la

ROI)
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ROI Histogram (Histogramme de la ROI)

« ROI Histogram » (Histogramme de la ROI) créera un histogramme pour une ROI définie par
I'utilisateur. Aprés avoir sélectionné I'élément du menu, placez le curseur de la souris dans
I'image affichée, appuyez sur le bouton gauche de la souris et maintenez-le enfoncé, puis faites
glisser le curseur pour effectuer la sélection de la ROl souhaitée. Relachez le bouton de la
souris. Les histogrammes s’affichent pour la ROI sélectionnée. Voir Figure 5.4.6.

La courbe noire est I'histogramme de la région sélectionnée. La courbe bleue est I'histogramme
de I'image entiére. Les deux courbes sont normalisées par rapport a la valeur maximale du
pixel de la région dintérét sélectionnée. Cliquez a nouveau sur « ROl Histogram »
(Histogramme de la ROI) pour désactiver la fonction.
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ROI Profile (Profil de la ROI)

L’option « ROI Profile » (Profil de la ROI) crée un profil pour une ROI définie par l'utilisateur.
Aprés avoir sélectionné I'élément de menu, placez le curseur sur I'image affichée. Maintenez
le bouton gauche de la souris enfoncé et déplacez le curseur sur I'image pour dessiner un cadre
défini par 'utilisateur autour de la ROI souhaitée. Reléchez le bouton gauche de la souris et un
profil s’affichera donnant la valeur de pixel individuel de la ROI définie. Voir Figure 5.4.27. Par
défaut, la direction de moyennage de la ROI sélectionnée est I'axe court. L’axe peut étre changé
en sélectionnant le bouton SWITCH, HOR<->VERT (BASCULER, HOR<->VERT). Cliquez a
nouveau sur « ROI Profile » (Profil de la ROI) pour désactiver la fonction.

Horizontal Region Profile
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5.4.5 Suite

Figure 5.4.26
ROI Histogram (Histogramme de
la ROI)

Figure 5.4.27
ROI Profile (Profil de la ROI)
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Line Profile (Profil de ligne)

L’option « Line Profile » (Profil de ligne) affichera un profil pour une ligne définie par I'utilisateur.
Aprés avoir sélectionné « Line Profile » (Profil de ligne), placez le curseur sur I'image affichée.
Maintenez le bouton gauche de la souris enfoncé et déplacez le curseur sur I'image pour tracer
une ligne définie par l'utilisateur. Relachez le bouton gauche de la souris et un profil sera
généré, affichant la valeur de pixel individuel de la ligne définie. Voir Figure 5.4.28. Par défaut,
le premier point sélectionné est toujours la partie la plus a gauche (prés de l'origine) du
graphique (c’est-a-dire que I'axe horizontal du graphique peut avoir des indices de pixels (i,i)
croissants ou décroissants, selon les points de début/fin sélectionnés). Cliquez a nouveau sur
« Line Profile » (Profil de ligne) pour désactiver la fonction.
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Built-In Window Level (Niveau de fenétre intégré)

Le logiciel Vision est livré avec une fonction de niveau de fenétre « intégré ». Il n’y a aucun
bouton ou élément de menu pour la sélectionner. La fonction « Niveau de fenétre » est
automatiquement activée chaque fois qu’'une image est acquise ou récupérée de la base de
données pour révision. Cette fonction permet a I'utilisateur de régler le contraste et la luminosité
de l'image a l'aide de la souris/du curseur.

Cliquez et maintenez le bouton gauche de la souris sur I'image affichée et déplacez le curseur
vers le haut et vers le bas pour modifier les niveaux de luminosité/obscurité ou déplacez le
curseur vers la gauche et vers la droite pour modifier les niveaux de contraste faible/élevé.
Déplacez le curseur jusqu’a ce que I'image atteigne les niveaux souhaités.

Figure 5.4.28
Line Profile (Profil de ligne)
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En appuyant sur le bouton, illustré a la Figure 5.5.1, situé en bas de la fenétre d’acquisition
d’'image, la bande des vignettes d’images du patient actuel apparait. Voir Figure 5.5.2.

N

BROWSER

La bande des vignettes affiche la date de la procédure pour chaque série d'images individuelles
en texte orange dans la partie supérieure.

L’image actuelle affichée dans la fenétre d’acquisition d’'images sera surlignée en vert.

La bande des vignettes est compatible avec les opérations de glisser-déposer pour placer les
images dans la zone d’affichage des images ou dans les volets de révision, selon les besoins.

De plus, d’'un simple clic, I'utilisateur peut sélectionner plusieurs images puis choisir parmi
différentes options pour enregistrer les images sur une clé USB, envoyer les images au PACS
ou supprimer les images. Les images sélectionnées sont mises en surbrillance en orange.

Des fleches s’affichent a gauche et a droite de I'’écran. Dans le cas ou de nombreuses images
sont prises, I'utilisateur peut parcourir les images prises, par date croissante, en appuyant sur
les fleches gauche/droite.

L’'option Open the Database (Ouvrir la base de données) (voir Figure 5.5.3) est aussi
disponible et fait entrer en mode Review (Révision). Ce bouton équivaut a appuyer sur Review
Mode (Mode Révision) dans le menu principal. Voir les Figures 5.0.1 et 5.6.1.

Le mode Révision est accessible en cliquant sur le bouton Review (Révision) dans la page du
menu d’accueil, Figures 5.6.1 et 5.0.1, ou sur le bouton Open Database (Ouvrir la base de
données) dans le navigateur d'images actuelles. Voir Figure 5.5.3. En cliquant sur I'un ou I'autre
de ces boutons, la base de données s’ouvrira comme indiqué dans la Figure 5.6.2. Le systéme
sera en veille pendant le mode de révision.

O

La base de données est essentiellement composée de trois sections ou sous-fenétres. La
section Patient List Table (Tableau de la liste des patients), a gauche, la section Procedure List
Table (Tableau de la liste des procédures), en haut a droite, et la section Image Thumbnail
List/Viewer (Liste/Visionneuse des vignettes d’'images), en bas a droite.

Navigateur pour
les images du
patient actuel

Figure 5.5.1
Icéne du navigateur pour les
images du patient actuel

Figure 5.5.2
Navigateur pour les images du
patient actuel

Figure 5.5.3
Bouton de la base de données
d’images

Base de données

Figure 5.6.1
Icone du mode de révision
affichée dans le menu d’accueil

Figure 5.6.2
Image Database (Base de
données d'images)
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Les tableaux des listes fonctionnent selon une hiérarchie descendante comme indiqué par la
fléche :

Liste des patients--->Liste des procédures--->Liste/Visionneuse des vignettes d’images.

La fenétre de sélection du patient est la fenétre située la plus en haut a gauche. La fenétre des
procédures est la fenétre située la plus en haut a droite.

Lorsqu’un champ Patient est sélectionné, la fenétre de procédure devient active. La fenétre de
procédure affiche une liste de toutes les procédures effectuées pour le patient sélectionné. De
plus, toutes les images correspondant au patient sont affichées en bas a droite. Il n’est pas
possible de sélectionner plusieurs patients.

Lorsqu'une procédure est sélectionnée, la liste/visionneuse des vignettes est filtrée pour
afficher uniquement les images correspondant a la procédure sélectionnée. Il est possible de
sélectionner plusieurs procédures en maintenant la touche Majuscule enfoncée et en cliquant
sur chaque procédure avec le bouton gauche de la souris. Toutes les images des procédures
sélectionnées s’afficheront en conséquence.

e Le tri de la base de données peut étre réglé en cliquant sur les champs supérieurs tels que
I'ID du patient et le nom de famille pour trier selon I'un ou l'autre des critéres. Lorsqu’un clic
de souris est fait sur I'un des champs de la base de données, une petite fleche s’affiche dans
le champ. En utilisant le bouton gauche de la souris et en sélectionnant a nouveau le champ,
le dessin de la fleche passe d’ascendant a descendant ou inversement. Le champ
sélectionné sera automatiquement trié en conséquence.

e Des barres de défilement sont situées dans la base de données pour faciliter la navigation.

o La liste/visionneuse des vignettes permet & un utilisateur de cliquer sur le symbole « + » pour
ajouter automatiquement I'image a un volet de révision. Un utilisateur peut ajouter jusqu'a
quatre images dans les volets de révision. Les volets de révision sont automatiquement
ajustés pour englober les quatre images.

e Les mémes options que celles disponibles dans le navigateur pour les images du patient
actuel (voir Figure 5.5.2) se trouvent également en haut de la base de données. Toutefois,
des options supplémentaires sont également disponibles ; elles sont décrites dans la
Section 5.5.2.

Remarque importante : les vignettes des images (.PNG) sont des fichiers distincts des fichiers
de données d’'images (DCM, DAT, DMM, RAW). Elles portent le méme nom de fichier que le
fichier d’image, mais elles ont une extension de fichier (.PNG). Il est possible d’avoir un fichier
image mais pas de « vignette ». Dans ce cas, Vision tentera de créer automatiquement une
vignette pour I'image qui doit étre chargée dans la base de données. Cependant, si cette
opération échoue, 'image ne sera pas affichée.

Save Image(s) (Enregistrer la/les images[s])

Le bouton Save Image(s) (Enregistrer la/les image[s]) est disponible lorsqu'une entrée du
tableau des images ou de la liste des vignettes est sélectionnée ou par le biais des images
patient actuelles, sinon il est désactivé. L'image sélectionnée peut étre enregistrée dans les
formats 8 bits courants suivants : JPEG, BMP, TIFF et RAW. Elle peut également étre
enregistrée au format TIFF 16 bits.

Le niveau de fenétre de I'image enregistrée est le niveau de fenétre par défaut. Si 'utilisateur
souhaite que le niveau de la fenétre soit modifié, il doit charger 'image dans Vue d’image et
'imprimer a partir de cet emplacement plutét que de I'imprimer a partir de la boite de dialogue
de la base de données.

Send Image(s) to PACS (Envoyer une/des image(s) au PACS)

Cette fonction envoie une ou des images a un serveur PACS DICOM préconfiguré. Reportez-
vous a la Section 5.7.0 pour plus d’informations.
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Fonctions et outils du menu de la base de données d’images 5.6.1

Il existe des fonctions pour naviguer, rechercher dans la base Optlor)s .
de données et pour modifier, supprimer et ajouter des ADDITIONAL OPTIONS supplémentaires
erjregi§trements a !a’ base de données. Ces fonctions spnt Open de la base de
détaillées dans les éléments du menu de la base de données. i d .
On y accéde a partir du bouton supérieur intitulé Additional F:rmt onnees
Options (Options supplémentaires) dans la base de View

données. Search Figure 5.6.3
Tools Menu d’options supplémentaires

Close Database

Menu Open (Ouvrir)

Le menu « Open » (Ouvrir) ne comporte qu’une seule option « Open Image from File » (Ouvrir
Iimage du fichier) qui ouvre une boite de dialogue Windows permettant a l'utilisateur de
naviguer et d’ouvrir des fichiers image situés sur des lecteurs locaux ou en réseau.

Menu Print (Imprimer)

Le menu « DB-PRINT » (IMPRIMER BD) offre des fonctionnalités d’impression par image, par
procédure et par patient. Voir Figure 4.6.4.

Figure 5.6.4
Menu d’impression de la base de

Print Image to Local Printer ;
données

Print Image(s) to DCM Printer

Print Image to Local Printer
(Imprimer I'image sur I'imprimante locale)

L’élément « Print Image to Local Printer » (Imprimer I'image sur 'imprimante locale) est
disponible lorsque la saisie a partir du tableau des images ou de la liste des vignettes est
sélectionnée, sinon il est désactivé. L'image sélectionnée sera imprimée avec I'imprimante
locale par défaut du systéme Windows.

Le niveau de fenétre de I'image imprimée est le niveau de fenétre par défaut. Il n’est pas
recommandé aux utilisateurs d’imprimer a partir de ce menu, sauf s’ils sont satisfaits des
impressions définies avec les niveaux de fenétre par défaut calculés par le programme.
L’utilisateur peut d’abord charger 'image dans la fenétre Image View (Vue d’'image) (Révision)
et ensuite régler I'image aux niveaux de fenétre souhaités. Lorsqu'’il est satisfait du niveau de
la fenétre, I'utilisateur peut alors lancer I'impression a partir du menu de la fenétre Image View
(Vue d’'image). Une boite de dialogue Format Options (Options de formats) permet de choisir
entre les formats d'impression.

Print Image(s) to DCM Printer
(Imprimer la/les image[s] sur I'imprimante DCM)

Cette fonction envoie la ou les images a une imprimante DICOM préconfigurée.

Menu View (Affichage)

Le menu « View » (Affichage) offre a I'utilisateur un certain nombre d’options affectant
I'affichage de la base de données. Voir Figure 5.6.5.

Figure 5.6.5
Show All DB Entries Menu d’affichage de la base de
Refresh DB Entries données

Browse Data Dir. (No DB)
Browse Any Dir. (No DB)
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Show All DB Entries (Afficher toutes les entrées de la BD)

Recharge le tableau Patient a partir du fichier de la base de données. Tout nouveau
changement ou ajout a la base de données sera appliqué au tableau. Cette sélection efface
également tout Search Filter (Filtre de recherche) actif qui aurait pu étre appliqué aux tableaux.
L’'option Search Filter (Filire de recherche) est expliquée en détail dans la partie Database
Search (Rechercher dans la base de données) ci-dessous.

Refresh DB Entries (Rafraichir les entrées de la BD)

Rafraichit le tableau des patients, mais conserve tout Search Filter (Filtre de recherche) existant
qui a été appliqué.

Browse Data Directory (No DB)
(Parcourir le répertoire des données [pas de BD])

Affiche toutes les vignettes d’images dans le répertoire des données établi par le fichier de
configuration. Ces fichiers sont affichés dans la visionneuse de vignettes. lls ne sont associés
ni a la base de données, ni aux listes des tableaux. Cet outil est utile pour examiner les images
non enregistrées ou pour déboguer les problemes de base de données lorsque des images
sont présentes dans le répertoire de données actuel.

Browse Any Directory (No DB)
(Parcourir n’importe quel répertoire [pas de BD])

Permet a I'utilisateur de naviguer dans n’importe quel répertoire de fichiers. Ces fichiers sont
affichés dans la visionneuse de vignettes. lls ne sont associés ni a la base de données, ni aux
listes des tableaux. Cet outil est utile pour examiner un répertoire d'images qui n’a jamais été
enregistré dans la base de données ou lorsque les enregistrements de la base de données sont
corrompus.

Menu Search (Rechercher)

Les outils « Search » (Rechercher) de la base de données, voir Figure 5.6.6, permettent
d’effectuer des recherches détaillées ou de filtrer la base de données. En sélectionnant le menu
« DB-Search » (Rechercher dans la BD), I'utilisateur peut effectuer une recherche détaillée et
spécifique. Lorsque le critere de recherche est saisi et activé dans la boite de dialogue de
recherche dans la BD, voir Figure 5.6.7, le filtre de recherche est appliqué a tous les tableaux
de listes de la boite de dialogue de la base de données d'image. Le critére de recherche activé
est appelé Search Filter (Filtre de recherche) et ce filtre reste actif jusqu’a ce que I'utilisateur
sélectionne « Stop Search » (Arréter la recherche) dans le menu « DB-Search » (Rechercher
dans la BD) ou « Show all DB Entries » (Montrer toutes les entrées de la BD) dans le menu
« DB-View » (Afficher la BD). Le filtre de recherche actif est toujours affiché dans la [égende de

la boite de dialogue de la base de données d'images.
Start Search
Stop Search

5.6.1 Suite

Figure 5.6.6

Menu de recherche dans la base

de données
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Start Search (Démarrer la recherche)

« Start Search » (Démarrer la recherche) ouvre la boite de dialogue de recherche dans la BD,
ce qui permet de placer un filtre de recherche actif sur la base de données. Lorsque la boite de
dialogue de recherche est ouverte, la page de la base de données est fermée et le logiciel
retourne a la page d’acquisition d'images. La page de la base de données se rouvrira
automatiquement apres la fermeture de la boite de dialogue de recherche.

DB SEARCH Dialog [E=5c)

SEARCH BY: Enter ACCESSION NUMEER
|[Ac:c:essionNumber] j |

CLICK -0K--TO ACTIMATE SEARCH FILTER ON THE DATABASE

(] 3 | Cancel I

Les menus déroulants proposent des listes de catégories de recherche. Sélectionnez une
catégorie de recherche et saisissez le paramétre de recherche souhaité pour lancer la
recherche. Sélectionnez « Start » (Démarrer) pour lancer la recherche. Si une catégorie a plus
d’une entrée distincte, alors toutes les entrées de cette catégorie seront affichées.

Stop Search (Arréter la recherche)

« Stop Search » (Arréter la recherche) désactive tout filtre de recherche actif, efface tous les
tableaux de listes et recharge la liste de tous les patients dans le tableau de la liste des patients.

Menu Outils

Le menu « DB-Tools » (Outils de BD) fournit des fonctions par image, par procédure, par
patient, ainsi que des fonctions utiles pour réparer ou reformater la base de données.

View
Search
Edit Image Record

e e Add Record to DB

Import Records in DIR to DB
Reformat All DB

Edit Image Record (Modifier le dossier Image)

La fonction « Edit Image Record » (Modifier le dossier Image) n’est pas disponible actuellement
dans le logiciel Vision.

Add Record to DB (Ajouter un dossier a la BD)

Disponible lorsque la saisie a partir du Tableau des images ou de la Liste des vignettes est
sélectionnée, sinon cette fonction est désactivée. Ceci est particulierement utile lorsqu’un
répertoire est parcouru alors que la base de données ne dispose d’aucune entrée pour les
images dans ce répertoire. L'utilisateur peut sélectionner une seule image dans la liste des
vignettes et ajouter des enregistrements de cette image dans la base de données. Si I'entrée
de la base de données existe déja pour 'image sélectionnée, il n’y a aucun danger, elle ne peut
que mettre a jour la base de données en fonction de I'endroit ou se trouve actuellement le fichier
image, c’est-a-dire le nom du fichier/dossier.

5.6.1 Suite

Figure 5.6.7

Démarrage d’une RECHERCHE
DANS LA BD

Figure 5.6.8

Menu Tools (Outils) de la base de

données
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Import Records in DIR to DB
(Importer des enregistrements de REP vers BD)

Cet outil permet de parcourir et de sélectionner un dossier, puis de remplir la base de données
avec toutes les entrées correspondantes pour tous les fichiers image dans le répertoire
sélectionné (y compris les sous-répertoires). Les formats d'images peuvent étre DCM, DAT,
DMM et RAW. Si des vignettes d’'images manquent, cet outil générera également des vignettes
BMP dans le méme répertoire.

Reformat All DB (Reformater toute la BD)

L’outil « Reformat All DB » (Reformater toute la BD) permet de reformater les champs Date
[AAAA/MM/JJ], Date/Heure [AAAA/MM/JJ HH:MM:SS] des tableaux et de mettre en majuscules
les lettres des entrées de certains autres champs. C’est un ouitil utile lorsqu’un ancien fichier de
base de données est importé et ouvert pour la premiére fois ou lorsque I'utilisateur modifie
manuellement les entrées de la base de données a I'aide de MS Access.

Remarques supplémentaires sur la base de données

e La possibilité de quitter la base de données, en restant dans le mode Review (Révision) se
trouve dans Additional Options (Options supplémentaires).

e Le bouton en haut a gauche se regle automatiquement pour ramener [l'utilisateur a
I'acquisition, ou au menu principal, ou il devient le bouton Close Database (Fermer la base
de données) selon le flux de travail utilisé pour aller a I'écran de la base de données et ce
qui est le plus approprié.

Modifier ou supprimer des informations
sur le patient de la base de données

L'utilisateur peut modifier ou supprimer des informations sur le patient dans la base de données.
Cliquez avec le bouton droit de la souris sur I'entrée du patient dans la partie supérieure de la
base de données pour ouvrir une boite de dialogue. Voir Figure 5.6.9.

1D6758 DOE 2015/03/3

D56 DOE 2019/03/2

Patient Name: F N JANE -
Patient ID: L JD8679
Date of Birth: 1920/03/23

pleipel 2l e rae et

Delete Patient Information

Cliquer sur « Edit Patient Information » (Modifier | =SS >
les informations sur le patient) ouvre une boite de
dialogue « Patient Information » (Informations sur <
le patient). Voir Figure 5.6.10. Cliquez sur Cancel
(Annuler) pour revenir a la base de données sans
effectuer ou enregistrer de modifications. Cliquer sur Save Changes (Enregistrer les
modifications) ouvre une boite de dialogue « Confirmation ». Cliquez sur Yes (Oui) pour
confirmer et continuer. Les modifications sont maintenant enregistrées et I'utilisateur sera
renvoyé a la base de données. No (Non) annulera les modifications et retournera a la base de
données. Cancel (Annuler) renvoie I'utilisateur a la boite de dialogue « Patient Information »
(Informations sur le patient).

Remarque : si le systéme a un mot de passe de démarrage activé (voir la rubrique Utilitaire de
connexion a la Section 5.4.4 et la Figure 5.4.21), le méme mot de passe sera demandé lors de
la tentative « Delete Patient Information » (Supprimer des informations sur le patient) de la base
de données.

5.6.1 Suite

Figure 5.6.9

Boite de dialogue Edit/Delete

(Modifier/Supprimer) (a gauche)

Figure 5.6.1
Informations
(a droite)

0
sur le patient
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La norme DICOM
Qu’est-ce que la norme DICOM ?

La norme DICOM (Digital Imaging and Communications in Medicine) est une série de
protocoles utilisés par les équipements et les logiciels médicaux pour permettre aux données
d’étre compatibles et interchangeables avec d’autres équipements ou logiciels médicaux.

Lorsqu’un fichier est enregistré dans un format DICOM, un fichier est créé. Celui-ci comprend
les données pertinentes du patient, les données de I'équipement d’'imagerie, du matériel ainsi
que les données d’image, le tout dans un seul fichier. De plus, le fichier enregistré contient des
caractéristiques spécifiques qui permettent a I'ordinateur et au logiciel de 'identifier comme un
fichier conforme a la norme DICOM. Une fois qu’une application logicielle reconnait le fichier
comme un fichier conforme a la norme DICOM, elle peut lancer un lecteur DICOM et extraire
les données correctement, quelle que soit I'origine du fichier.

Un fichier créé & I'aide du protocole DICOM a la structure suivante.

Preamble Header

Prefix

Data Element

Data Element

Lorsque le préambule est constitué de 128 octets, tous sont
généralement définis sur 00H, sauf s'il n'est pas utilisé par un
profil d’application ou une implémentation spécifique ; le préfixe Data Element Data Set
est constitué de 4 octets, constituant la chaine de caracteres
« DICM » codée en majuscules du répertoire de caractéeres GO
de la norme ISO 8859 ; les éléments de données sont
arbitrairement grands (ou petits) et contiennent les données. Data Element

Data Element

Data Element

Modalité

Les paramétres du fichier DICOM pour la modalité sont accessibles a partir de la barre de menu
supérieure en sélectionnant « DICOM Utilities » (Utilitaires DICOM), puis « DICOM Modality

Setup » (Configuration de modalité DICOM).
Hel

DICOM MODALITY Setup
DUMP DICOM Header

Le type de stockage DICOM, soit Présentation soit Traitement, peut étre sélectionné. La méme
boite de dialogue permet de sélectionner la modalité d’'image DICOM, soit radiographie
numérique soit mammographie numérique. Les paramétres « Transfer Syntax » (Syntaxe de
transfert) et « Value Representation » (Représentation de valeur) ne peuvent pas étre définis
par l'utilisateur. lls sont toujours paramétrés sur META HEADER PRESENT, LITTLE_ENDIAN
et VR_IMPLICIT.

Fonctionnalité
DICOM

Figure 5.7.1
Structure du protocole DICOM

Figure 5.7.2
Menu DICOM Utilities (Utilitaires
DICOM)
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[Dicom Dl

DICOM Storage Type Walue Fepresentation Figure‘5. 7.3 "
Parametres de Modalité DICOM
¥ Storage For Presentation % Implicit Paramétres par défaut

" Starage For Proceszing (" Ewplicit*

DICOM Image kodality Transfer Syntax

# Digital #-ray Image [General] & Litle Endian

(™ Digital -ray Mammoagraphy Image " Big Endian®

] IMPLICIT-¥F and LITTLE-EMDIAN suntax iz recommendad. Other options may
not be fully compatible with third party zoftware or DICOM services. IMPLICIT YR
and BIG-EMDIAN catnot be simultanecusly selected.

Default DICOM Servers
STORE 1|

STORE 2 |
[+ Enable Single-Click Auba Store

PRINT |
[ Enable Single-Click Auto Print

MWL |

[v Enable uto Search When Connecting to MWL Server
[¥ Enable Single-Click Auto ML Connection

[ Autocloze dialog after 5 zeconds of successful ransfer/printing.

Click DICOM Servers buttan ta add. configure
DICOM Servers... | o delate DICOM servers.
]9 | Cancel

REMARQUE : une fois les modalités DICOM sélectionnées, elles restent en vigueur, méme
aprés la fermeture du logiciel Vision. Les parameétres de la modalité sont stockés et resteront
mémorisés dans la configuration jusqu’a ce qu’ils soient modifiés a nouveau, en utilisant les
paramétres du fichier DICOM. Ces paramétres (de type de stockage et de modalité, de syntaxe
de transfert, et de représentation des valeurs) seront effectifs pour toutes les fonctionnalités
DICOM « Local Save » (Enregistrer en local) ou « Local Print » (Imprimer en local).

Default DICOM Servers (Serveurs DICOM par défaut)

Cette section contient des paramétres pour les serveurs DICOM par défaut et pour automatiser
certains des processus lors du stockage, de 'impression ou de la recherche de serveurs PACS
et MWL.

Les cases a cocher « Enable Single-Click Auto Store » (Activer le stockage automatique en un
seul clic), « Print» (Imprimer) ou « MWL Connection » (Connexion MWL) permettent a
I'utilisateur de stocker ou d’imprimer des images ou de se connecter automatiquement au
serveur MWL. Si vous utilisez un seul serveur PACS pour ces actions ou si la majorité de votre
travail concerne un seul serveur PACS, cochez la case souhaitée pour automatiser ces actions.

La case « Enable Auto Search When Connecting to MWL Server » (Activer la recherche
automatique lors de la connexion au serveur MWL) indique a lapplication d’effectuer
automatiquement une recherche avec les paramétres de recherche par défaut lors de la
recherche des données des patients.
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La case « Auto close dialog after N seconds of successful transfer/printing » (Fermeture
automatique de la boite de dialogue aprés N secondes de transfert/impression réussife]) ferme
automatiquement la boite de dialogue du réseau DICOM aprés un nombre de secondes
spécifié. La boite de dialogue ne se ferme pas automatiquement en cas d’erreur de transfert ou
d’'impression.

Cliquer sur le bouton DICOM Servers (Serveurs DICOM) ouvre la boite de dialogue réseau
DICOM ou un utilisateur peut ajouter, modifier ou supprimer des serveurs DICOM. Voir
Figure 5.7.5.

DICOM Save Local (Enregistrer DICOM en local)

Pour enregistrer 'image actuelle sur un lecteur local/répertoire, cliquez avec le bouton droit de
la souris n'importe ou dans l'image. Cela affichera la boite de dialogue présentée dans la
Figure 5.7.4 ci-dessous. Cliquez sur « Save/Store current image » (Enregistrer/Stocker I'image
actuelle) puis sur « As Local DICOM image » (En tant qu’image DICOM locale). Cela fera
apparaitre la boite de dialogue standard d’enregistrement de fichiers de Windows. Naviguez ou
cliguez sur le répertoire/dossier souhaité, entrez le nom du fichier et cliquez sur Save
(Enregistrer).

LI IETE CUITENT IMAge recora

Add new record
Save/Store current image v LIS Archive image
Print current image 4 As local DICOM image

As local image

More options...

PACS STORE (ENREGISTREMENT PACS) et PACS PRINT
(IMPRESSION PACS)

Le logiciel Vision permet I'enregistrement PACS (DICOM) et 'impression PACS (DICOM). Ces
options sont disponibles dans I'ensemble du logiciel. Par exemple, si le bouton PACS Store
(Enregistrement PACS) est sélectionné, la fenétre de dialogue suivante avec le réseau DICOM
peut étre affichée. Cette boite de dialogue permet a I'utilisateur d’effectuer un enregistrement
DICOM, d’effectuer une impression DICOM, ou d’ajouter, de modifier ou de supprimer des
connexions réseau ou des périphériques DICOM.

4 DICOM Networking Dialog - Biop
SESSION SECURITY VIEW COMMAND PREFERENCES

Session [ ~ | DICOM Network Connections

ADD Session g E E
ORI esn DICOM Store 1 DICOM Print 1 SBICOH B

REMOVE Session

ASSOCIATION List

DICOM Network Messages Log

CLOSE

Figure 5.7.4

Boite de dialogue Save Current
Image (Enregistrer l'image
actuelle)

Figure 5.7.5
Boite de dialogue DICOM
Networking (Réseau DICOM)
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PACS DICOM STORE (ENREGISTREMENT PACS DICOM)

Le logiciel Vision prend en charge le service C-STORE DICOM 3.0. Ceci permet d’envoyer une
image ou une série d’'images (selon une procédure spécifiée) a un systeme de stockage distant
conforme a I'entité d’application (AE) DICOM, comme le PACS. La encore, la fonction DICOM
Store (Enregistrement DICOM) est accessible dans I'ensemble du logiciel Vision. Les
modifications de la présentation et du traitement peuvent étre effectuées par le biais de la
configuration de la modalité DICOM, dans le menu Tools (Outils).

Remarque : pour 'enregistrement DICOM, la case « SET FILM Attributes » (PARAMETRER
les attributs du film) est grisée.

L’utilisateur peut ajouter une nouvelle configuration pour une AE DICOM distante a laquelle
envoyer I'image ou choisir parmi une configuration déja existante, affichée dans Connexions
réseau DICOM, dans la boite de dialogue DICOM Networking (Réseau DICOM). En double
cliquant (ou avec un seul clic et en appuyant sur le bouton Connect) sur I'icone de 'AE DICOM
distante, le logiciel Vision se connecte et établit une association DICOM avec I'AE distante
sélectionnée. Une fois que l'association réussie, I'image peut étre envoyée pour étre
enregistrée en appuyant sur le bouton Store (Enregistrer). Aprés avoir sélectionné le bouton
Store (Enregistrer), le logiciel Vision envoie 'image sélectionnée a I'AE DICOM distante définie.
Si 'opération de mémorisation est réussie, 'AE DICOM distante envoie une confirmation de
réception et d’enregistrement de la ou des images. Si I'opération échoue, 'AE DICOM distante
enverra un code d’erreur indiquant la raison de I'échec.

Une seule image peut également étre envoyée pour étre enregistrée en cliquant avec le bouton
droit de la souris sur la vignette de I'image (dans le navigateur de la base de données) et en
suivant la méme procédure que celle décrite précédemment. Il est possible d’envoyer toute une
série (Procédure) d’images pour enregistrement. Pour ce faire, cliquez avec le bouton droit de
la souris sur le nom de la série (Procédure), affiché dans I'écran du navigateur de base de
données, puis suivez le méme protocole que celui décrit ci-dessus.

Add Session (Ajouter une session)

Le bouton Add Session (Ajouter une session) ouvre la boite de dialogue de session par
laquelle l'utilisateur peut configurer une nouvelle connexion a une entité d’application DICOM
distante.

Pour créer une nouvelle configuration de connexion a une AE DICOM distante, I'utilisateur doit
disposer des informations suivantes : le titre de I'entité d’application (AE Title), le choix de la
« fonction a exécuter » DICOM/PACS, I'adresse IP et le numéro de port du serveur (c’est-a-
dire de I'imprimante DICOM ou du systéme PACS).

Le titre AE et le numéro de port du systéme de I'utilisateur (c’est-a-dire le client) sont également
nécessaires. Remplissez les champs de données correspondants et sélectionnez OK pour
créer une nouvelle configuration.
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Choix du comportement de la fonction
de session DICOM/PACS par défaut

Il'y a actuellement quatre (4) types de fonctions qu’une session DICOM peut utiliser par défaut.
Celles-ci se trouvent dans la liste déroulante Fonctions (cases combinées) comme indiqué dans
les figures ci-dessous. La liste est la suivante :

1. Connexion GENERAL (GENERALE) (‘8 DICOM Session Propertie =)
DICOM/PACS. Neware | —
2. Connexion STORE (ENREGISTREMENT) S I—IE |
DICOM. e | e
3. Connexion PRINTER (IMPRIMANTE) B
DICOM. Function: |GENEHAL ﬂ
4. Connexion WORKLIST (LISTE DE paddess [PRNT
TRAVAIL) de la modalité. * JWORKLIST
Part Murnber: |0
Client
AE Title:  |FAXITRON_DR
Port Mumber: |0

Le but de la « Fonction » DICOM est de permettre la création (I’ajout) d’'une Session/Connexion
qui a son tour permet d’utiliser un « dispositif » DICOM/PACS uniquement tel que I'utilisateur
I'a configuré pour une catégorie de fonctions particuliere. Une fois configuré, lorsque vous
visualisez ou utilisez la « DICOM Networking Dialog » (Boite de dialogue réseau DICOM) (voir
Figure 5.7.5 ci-dessus), seule l'icone correspondant a la fonction choisie sera « active et
illuminée ». C’est-a-dire qu’elle aura une couleur bleue par opposition & une couleur « grisée ».
Par exemple, dans la Figure 5.7.5 ci-dessus, il y a trois (3) icbnes représentant, dans 'ordre :
un enregistrement PACS (DICOM Store 1), une impression PACS (DICOM Print 1) et une liste
de travail des modalités (DICOM-MWL). Comme l'icone DICOM Store (Enregistrement
DICOM) a été choisie précédemment, elle est la seule active (écran bleu). Les autres modes
fonctionnent de la méme maniére.

Modify Session (Modifier la session)

Le bouton Modify Session (Modifier la session) ouvre la boite de dialogue pour 'AE DICOM
sélectionnée. Dans cette fenétre, I'utilisateur peut modifier les informations du serveur et du
client décrites dans la partie Add Session (Ajouter une session).

Remove Session (Supprimer la session)

Le bouton Remove Session (Supprimer la session) supprime la configuration de 'AE DICOM
sélectionnée du logiciel Vision. Une fois supprimée, une configuration AE DICOM ne peut pas
étre restaurée, sauf si I'utilisateur saisit & nouveau manuellement les données requises par le
biais du bouton Add Session (Ajouter une session). Une confirmation d’action sera demandée,
voir ci-dessous.

r -
Vision l"' "“*""J

Figure 5.7.6

Boite de dialogue Session
Properties (Propriétés de la
session)

Figure 5.7.7

Veérification de la suppression
d’une connexion réseau DICOM
existante
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Le bouton Association List (Liste des associations) ouvre la boite de dialogue Association,
représentée ci-dessous, grace a laquelle l'utilisateur peut modifier les paramétres et les
protocoles utilisés par le logiciel Vision lors de la négociation d’'une connexion avec une AE
DICOM distante. Ces options doivent étre modifiées uniquement par un utilisateur avancé,

Association

familiarisé avec les protocoles d’association DICOM.

Eﬂ DICOM Association

)

Wersion:

—

Application Contest:

tdax Drata Length:

|1.2.84D.1DUUS.3.1.1.1

16384 ¥ Enabled

Implernentation Class:

|1 .2.840.114257 1123456

Implementation Yersion: |1

i ax Operation lrvoked:

tdax Operation Performed:

" Enabled

Caticel

¥ Enabled
¥ Enabled

Abstract Syntax:

4

Timeout [rns]:

Yerific.ation Class

B asic: Film Session Class

B asic: Film Box Clazs

Bazic Grayzcals Image Box Clazs

Bazic Grayzcals Print banagement Meta Class

Frint Job Clazz
Basic Annotation Box Clazs
Printer Clazs

m.| »

Select Al
Deslectal |

Deselect ll

td dify
<2 Drefault

[ mm

50000

b

Attributs du film

En sélectionnant « Set DICOM Print Film Attributes » (Paramétrer les attributs d’impression du
film) dans le menu « Command » (Commande) (Figure 5.7.9), la boite de dialogue de
configuration de I'imprimante DICOM s’affiche. Voir Figure 5.7.10. Dans cette boite de dialogue,
I'utilisateur peut sélectionner diverses options régissant le film et le format d’'impression. La
sélection de l'option Default (Par défaut) rétablit toutes les options par défaut. Les
configurations des paramétres sont accessibles via des menus déroulants. Pour accepter la
configuration modifiée, sélectionnez OK. Pour rejeter les options et quitter la fenétre sans

apporter aucun changement, sélectionnez Cancel (Annuler).

;'g DICOM Networking Dialog - Bioptics Vision

SESSION  SECURITY VIEW COMMAND PREFERENCES

ADD Session | B
MODIFY Session | m

REMOVE Session |
ASSOCIATION List |

|
DISCONNECT
ECHO ON/AOFF |

ECHO ON/OFF
CHECK ASS0C. FOR STORAGES

SELECT DICOM File & DICOM STORE

SELECT DICOM File & DICOM PRINT
SET DICOM PRINT FILM Attributes
DICOM PRINT Selected

DICOM C-FIND Patient Root...
DICOM C-FIND Study Root...
DICOM C-FIND Patient/Study Only.
DICOM C-FIND Modality Workdist...

DICOM RETRIEVE

CANCEL Command

5.7.0 Suite

Figure 5.7.8
Fenétre Association DICOM

Figure 5.7.9
Paramétrer les attributs
D’'IMPRESSION DU FILM DICOM
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DICOM Printer Setup X

Wedium Type Elue Film

4

Print Priority [High

4

= L 1 1 b i e e e

MNumber of Copies |1

Filrn Destination |Magazine

Film Orientation [Portrait

Ermpty Image Density |Ellack

Border Density |El|ack

Magnification Type | REPLICATE

Film Size ID [aim<1 i -
Polarity |N0rmal
Smaothing Type |Medium

Film Density

hax Density WLJ
Min Density [0 4

Image Display Format

. B
@ sTANDARDY [+ [1 <]

" Slide

Default QK | Cancel

PACS PRINT (IMPRESSION PACS)

L’option PACS Print (Impression PACS) envoie I'image sélectionnée a I'imprimante PACS
DICOM sélectionnée. L'image est imprimée selon les options de format de film et d’'impression
spécifiées dans la boite de dialogue Set Film Attributes (Configurer les attributs du film) décrite
précédemment. Si 'utilisateur lance l'impression PACS a partir de Image View (Vue image),
alors le niveau de la fenétre sera choisi dans cette vue image. Si I'impression PACS est lancée
a partir de la boite de dialogue Base de données, alors le niveau de la fenétre sera le niveau
de fenétre par défaut calculé par le logiciel Vision.

Close (Fermer)

Le bouton Close (Fermer) ferme la boite de dialogue DICOM Networking (Réseau DICOM) et
fait revenir I'utilisateur dans la zone a partir de laquelle la commande DICOM a été exécutée.
Cette commande ferme également la connexion ou I'association entre le logiciel Vision et le
périphérique DICOM distant si une connexion a été établie.

5.7.0 Suite

Figure 5.7.10
Boite de dialogue de
configuration de I'imprimante

DICOM
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Vue d’ensemble

L’'option User Annotations (Annotations de l'utilisateur) dans le logiciel Vision permettent
d’appliquer une « superposition » graphique transparente sur une image, communément
appelée « annotations ». Ces annotations peuvent étre un texte, des lignes, des lignes de
« forme libre » (courbes de Bézier), des fleches, des ellipses et des boites. Cela permet
d’ajouter des informations supplémentaires et des « marqueurs » sur 'image si besoin. Notez
que toutes les annotations peuvent étre facilement activées ou désactivées, en d’autres termes,
elles peuvent étre affichées ou masquées a volonté.

Opérations

Pour commencer I'annotation, sélectionnez I'outil Annotations dans le menu de gauche. Voir
les Figures 5.4.1 et 5.8.1. En ouvrant cette boite de dialogue, le logiciel met immédiatement
I'utilisateur en mode conception. |l affichera aussi une « palette d’outils ». Voir Figure 5.8.2
ci-dessous.

Le fait de sélectionner Save (Enregistrer) ou Cancel (Annuler) dans cette boite de dialogue
annulera les annotations précédentes ou enregistrera les annotations actuelles dans la fenétre.
Il vous raménera également au mode d’imagerie normal.

La palette d’outils est composée des quinze (15) options d’outils suivants. Cependant, les outils
peuvent étre tronqués aux 8 oultils les plus courants, en fonction des besoins de l'utilisateur ; ils
sont affichés dans la ligne supérieure de la boite de dialogue.

Notez que le comportement de la plupart de ces options d’outils implique I'utilisation de la souris
pour guider la position et la forme dynamiques a I'écran. Les « clics » de la souris sont utilisés
pour définir les positions et les formes finales. Le terme « balayer » signifie que I'on maintient
le bouton gauche de la souris enfoncé et que I'on déplace I'objet sur I'écran. Le fait de relacher
le bouton gauche de la souris ou de cliquer sur le bouton droit de la souris mettra I'annotation
en position « permanente » ou finale.

Mew Preset Name Here

Add as New Preset

5.8.0
Annotations de
I'utilisateur

Figure 5.8.1
Icéne d’annotations

Figure 5.8.2
Palette d’outils de conception des
annotations de ['utilisateur
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En commencgant dans le coin supérieur gauche de la Figure ci-dessus, une description de
chaque option d’outil est donnée ci-apres.

Outil de sélection : utilisez cet outil pour sélectionner (mettre en surbrillance) un objet
d’annotation courant. Cliquez et maintenez le bouton gauche de la souris enfoncé, ce qui
définit une position de départ, puis déplacez la souris. Les annotations qui se trouvent a
I'intérieur de la boite affichée seront sélectionnées pour une utilisation ultérieure. Relachez
le bouton gauche de la souris pour terminer I'opération.

Outil ligne : cette option permet de tracer une ligne droite. Le comportement de la souris est
le méme que ci-dessus.

Outil boite : dessine une boite. Le comportement de la souris est le méme que ci-dessus.

Outil ellipse (et cercle) : dessine une ellipse ou un cercle. Le comportement de la souris est
le méme que ci-dessus.

Outil fleche : dessine une ligne avec une fléche & son extrémité. Le comportement de la
souris est le méme que celui de I'outil ligne.

Outil ligne ouverte de polygone : dessine des lignes non droites « a segments ouverts ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez
sur le bouton droit de la souris et le fonctionnement de I'outil se termine.

Outil texte : crée une « zone de texte » ou vous pouvez saisir des données sous forme de
texte.

Outil régle : crée un segment de ligne gradué. Trés similaire a la fonction Régle des outils
d’'image.

Outil ligne fermée de polygone : dessine des lignes non droites « a segments fermés ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne. Répétez autant de fois que désiré. Cliquez
sur le bouton droit de la souris et le fonctionnement de I'outil se termine.

Outil ligne courbe ouverte : dessine des lignes courbes « ouvertes et segmentées ».
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfonceé,
dessinez. Relachez le bouton de gauche, cela définit un segment de ligne courbe. Répétez
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de
I'outil se termine.

Outil ligne courbe fermée : dessine des lignes courbes « fermées et segmentées ».
(Courbes de Bézier.) Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé,
dessinez. Relachez le bouton de gauche, cela définit un segment de ligne courbe. Répétez
autant de fois que désiré. Cliquez sur le bouton droit de la souris et le fonctionnement de
I'outil se termine.

Outil infobulle (texte) : crée une zone de texte avec un segment de ligne dépassant d'un
coin de la zone de texte. Ceci peut étre utilisé pour « relier » le texte a un élément sur votre
image.

Régle segmentée : dessine des lignes graduées non droites « ouvertes et segmentées ».
Cliquez sur le bouton gauche de la souris, maintenez le bouton enfoncé, dessinez. Relachez
le bouton gauche, ceci définit un segment de ligne gradué. Répétez autant de fois que désiré.
Cliquez sur le bouton droit de la souris et le fonctionnement de I'outil se termine. La longueur
de tous les segments de ligne gradués est indiquée a I'extrémité de la régle. Utile pour une
estimation approximative de la circonférence d’'un objet ou d’'un patient.

Outil rapporteur : dessine un angle sur I'écran et indique la valeur de I'angle en degrés.
Comme un rapporteur.

Outil régle orthogonale : crée deux (2) lignes graduées orthogonales (I'une par rapport a
l'autre).
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Mode de conception et menu contextuel (clic droit de la souris)

En mode User Annotation Design Mode (Conception des annotations de I'utilisateur), mais pas
dans un mode de fonctionnement spécifique, il est possible de faire un clic droit de la souris
pour afficher un menu contextuel. Voir ci-dessous.

Narne...

Line...

ROP2...

Transparent

Transparent Color...

Fill...

Foreground Color...
Background Color...

Text Color...

Mote Background Color..,
Redact Background Color...
Hilite Background Celor...
Font...

Button Font...

Unde Hotspot Metafile...

Cut Encrypt Metafile...

Copy Decrypt Metafile...

Paste Ruler...

Delete Modes...
Protractor...

Select All
Show Stamp Border

Bring to Front Point...

Send to Back

Encrypt...
Hide Rotate Handles for All Objects Fixed...
Default Properties » Hyperlink...

De nombreux réglages spécifiques peuvent étre effectués a partir de ces menus contextuels.

Remarque : si un élément semble trop petit pour étre lu ou vu correctement, vous pouvez
éventuellement le modifier a partir des menus contextuels présentés ci-dessus. Vous pouvez
également choisir de zoomer dans I'image a l'aide de I'outil Dynamic Zoom (Zoom dynamique).
Ceci agrandit 'image et vous devriez pouvoir voir clairement toutes les annotations.

Afficher/Masquer les annotations

Le bouton Toggle Annotations (Basculer les annotations) illustré a la Figure 5.8.4,
permet aux utilisateurs d’activer et de désactiver rapidement les annotations. Par
défaut, les annotations seront activées. Le bouton est situé dans le menu de droite,
prés du coin supérieur droit.

=

Le sous-menu « Help » (Aide), voir Figure 5.9.1, est situé sur la barre de menu supérieure et
permet d’accéder rapidement au « User's Manual » (Manuel de I'utilisateur) Faxitron Path et &
« About Vision » (A propos de Vision). Voir Section 5.10.0 et Figure 5.10.1.

Open User's Manual

About Vision

5.8.0 Suite

Figure 5.8.3

Menu contextuel de la souris (clic
droit) (uniquement en mode de
conception des annotations de
l'utilisateur)

Figure 5.8.4

Option Show/Hide
(Afficher/Masquer) pour les
annotations de I'utilisateur

5.9.0
A propos de I’'Aide

Figure 5.9.1
Boite de dialogue de I'aide en
ligne
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Le bouton About Vision (A propos de Vision) ouvre une boite de dialogue qui affiche la version

du logiciel Vision, la date de copyright et les informations sur le systéme.

About Vision
Yision Yersion 3.1.4.Revl U (64-Bif)
Copyright (C) 2005-2018 Faxitron Bioptics LLC

“ersion# 3.0.3.1 Mame: FBFrocessing.dll

Frocessing Library Information ———

—— Camera Library Information
“ersion# 1.0100 Mame: BiCamTLDS dll

“Yersion#1.2.1.1

Camera Information

Configuration Litility Information —

hake: Teledyne Dalsa, Senak SERIALY
hodel: xineaos 2923
Sensortype: TOLS_2304x2944

*-Ray System Information

bake: BIOPTICS, Maodel: PATHWISION
Firrmware Yearsion# PAT01.05

x

5.10.0

A propos du
logiciel Vision
Figure 5.10.1

Boite de dialogue d'informations

About Vision (A propos du logiciel
Vision)
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Faxitron’ Path Conformité

Systéme de radiographie d’échantillons et sécurité

Exigences | Conformité de Faxitron Path

. L Exigences de
Limites en émission ez
Le rayonnement émis par I'unité Faxitron Path+ ne dépasse pas une exposition de 0,1 milli- conformiteé et
Roentgen (mR) par heure en un point quelconque situé a 5 centimétres (cm) a I'extérieur de mesures de
la surface externe. Pour les pays exigeant des valeurs d’émission mesurées a 10 cm des sécurité
surfaces externes, le rayonnement ne dépasse pas 0,1 mR par heure a 10 cm.

Verrouillages de sécurité
Le systéme DR d’échantillons Faxitron Path est doté de deux verrous de sécurité situés sur la
porte du compartiment a échantillon.

Bouton de démarrage

Aprés l'interruption de la génération de rayons X par les verrouillages de sécurité, le bouton
Start (Démarrage) du panneau avant reprendra la génération de rayons X lorsque le systéeme
sera prét.

Commande par clé

Interrupteur a clé situé sur le panneau avant, qui nécessite d’insérer une clé et de la tourner
dans le sens des aiguilles d’'une montre jusqu’a la position « 3 heures » pour mettre sous
tension le systéme de I'armoire. La clé ne peut pas étre retirée en position « MARCHE ».

Bouton d’arrét d’'urgence

Le bouton d’arrét d'urgence du panneau avant du Faxitron Path permet de mettre fin a la
génération de rayons X. C’est un élément supplémentaire qui s’ajoute aux verrouillages de
sécurité des portes du systéeme.

Voyants de génération de rayons X

Le Faxitron Path est doté d’un voyant lumineux d’activation de rayons X sur le panneau avant
et sur linterface utilisateur graphique ; il émet également un signal sonore pendant la
génération de rayons X.

Puissances nominales
100-240 50/60 HZ 200 W MAX.

Production de chaleur
500 BTU/h MAX.

LOCALISATEUR LASER
Le Faxitron Path utilise une paire de lignes générées par laser pour aider a positionner les
échantillons au milieu du champ d’'imagerie.

Parameétres des lasers .
Les lasers sont conformes a la norme CEl 60825-1: Edition 3.
Produits laser de classe 2.

Longueur d’onde : 670 nm.
Puissance de pointe : 1 mW.
Largeur des lignes : 1 mm standard.

Divergence des faisceaux : 85° standard.
Les lasers ne nécessitent aucun assemblage.

L’opérateur n’est pas autorisé a effectuer des opérations de maintenance sur les lasers. Les
lasers doivent étre entretenus uniqguement par un représentant autorisé de Hologic.

PARAMETRES ELECTRIQUES DES LASERS
Tension de fonctionnement : rouge : 3-6VDC.
Noir : terre.
Courant de fonctionnement : 50 mA standard.
80 mA MAX.

HOLOGIC

MANUEL DE L’'UTILISATEUR DU FAXITRON PATH | HOLOGIC | REVISION 002 6-2




Faxitron® Path

Systéme de radiographie d’échantillons

Conformité
et sécurité

MISES EN GARDE :

RAYONNEMENT LASER DE CLASSE 2 LORSQUE LA PORTE EST OUVERTE. NE FIXEZ
PAS LE FAISCEAU.

Un rayon laser peut étre dangereux pour les yeux. NE REGARDEZ PAS dans I'ouverture du
laser lorsque celui-ci est en fonctionnement.

La lumiére laser peut également étre dangereuse lorsqu’elle est réfléchie sur une surface
similaire & un miroir.

Pour plus d’'informations sur la sécurité des lasers, consultez la norme ANSI-Z1 36.1 STANDARD
FOR THE SAFE USE OF LASERS, disponible auprés du Laser Institute of America, téléphone
407-380-1553.

REMARQUE : les ouvertures du laser sont situées dans le plafond de la chambre a rayons X.

Etiquette de MISE EN GARDE de laser : Situé dans le coin supérieur droit de la porte et
derriére la porte.

<{Emm AVOID EXPOSURE

LASER RADIATION IS
EMITTED FROM THIS APERTURE

LASER RADIATION
AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAK POWER 1mW
WAVELENGTH 670nm
LASER RADIATION IEC 60825-1:2014
AVOID DIRECT EYE EXPOSURE
CLASS 2 LASER PRODUCT
PEAK POWER 1mW Translations in Box
WAVELENGTH 670nm

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,
DATED JUNE 24, 2007

/A CAUTION

|EC 60825-1:2014

COMPLIES WITH 21 CFR 1040.10
AND 1040.11 EXCEPT FOR DEVIATIONS
PURSUANT TO LASER NOTICE NO.50,

DATED JUNE 24, 2007
Translations in Box

LBL-11347 Rev. 002

CLASS 2 LASER RADIATION WHEN OPEN
DO NOT STARE INTO THE BEAM

LBL-11353 Rev. 002
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Version DICOM

Hologic utilise la derniére norme DICOM :

ACR-NEMA Digital Imaging and Communications in Medicine (DICOM) v3.0, version finale,
ao(t 1993.

Et est conforme a :

NEMA PS 3.1 — 3.20 (2016), Digital Imaging and Communications In Medicine Set.

Classes de stockage

FAXITRON_DR fournit une conformité standard a la classe DICOM V3.0 SOP suivante en
tant que SCU.

Classe SOP du SCU

Classe SOP UID de la classe SOP
Computed Radiography Image Storage SOP 1.2.840.10008.5.1.4.1.1.1
Digital X-ray Image Storage Presentation 1.2.840.10008.5.1.4.1.1.1.1
Digital X-ray Image Storage Processing 1.2.840.10008.5.1.4.1.1.1.1.1

Digital X-ray Mammography Image Storage Presentation|1.2.840.10008.5.1.4.1.1.1.2
Digital X-ray Mammography Image Storage Processing [1.2.840.10008.5.1.4.1.1.1.2.1

Study Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.2.1
Patient Root Query/Retrieve Info. Model -FIND 1.2.840.10008.5.1.4.1.2.1.1
Modality Worklist information Model-FIND 1.2.840.10008.5.1.4.31
Greyscale Softcopy Presentation Storage 1.2.840.10008.5.1.4.1.1.111

Pour plus de détails, consultez la déclaration de conformité « Full DICOM » enregistrée sur le
systéeme. Le fichier se trouve dans C:\Faxitron et un raccourci est fourni sur le bureau.

Si nécessaire, une copie de la déclaration de conformité DICOM est disponible sur demande
aupres de Hologic.

6.2.0
Norme DICOM
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Entretien et
dépannage

Entretien

L’équipement Hologic ne contient aucune piéce réparable. Veuillez contacter votre
représentant Hologic agréé pour toute réparation.

Etats-Unis : +1.877.371.4372
Europe : +32 2711 4690
Asie : +852 37487700
Australie : +1 800 264 073
Autres pays : +1 781999 7750

Courrier électronique : BreastHealth.Support@hologic.com

Dépannage

L’ordinateur ou le systéme ne s’allume pas

Pas d’alimentation électrique de I'ordinateur ou du systéme de radiographie.

Vérifiez que le systéme est sous tension (MARCHE) et que la fiche d’alimentation est
branchée et sous tension.

Le voyant READY (PRET) ne reste pas sur « activé »
Le bouton a été pressé AVANT que le logiciel Vision ne soit lancé ou avant que le logiciel
n’arme le systéme de radiographie pour une acquisition. Voir Démarrage rapide.

L’image semble indiquer qu’il y a un autre objet dans I'unité de rayons X
Veérifiez que pendant I'étape « Etalonnage », aucun autre objet n’était présent dans I'armoire
a rayons X. Retirez les objets et répétez I'étape Etalonnage.

Mauvaise qualité des images

Vérifiez que les valeurs d’intensité de I'image (I (x,y)) qui se trouvent dans le coin inférieur
droit de la fenétre d’affichage de Iimage sont proches de la valeur ADU cible de 10 000.
lorsque la cible DE pré-photo de I'exposition de 'AEC est également fixée & 10 000 ADU et
que le mode d'exposition est Auto kV/Auto Time. Si nécessaire, répétez la procédure
d'Imagerie.

Cybersécurité

Si un événement lié a la cybersécurité se produit, déconnectez le systéme du réseau et
contactez immédiatement Hologic. Nous travaillerons avec votre département informatique
pour résoudre le probléme.

Un événement lié a la cybersécurité peut étre détecté de plusieurs fagons :
e Fonctionnement et/ou connexion au réseau plus lents que la normale.

e Fenétres contextuelles suspectes ou page d’accueil modifiée dans le navigateur
Internet.

e Mot(s) de passe inopérant(s).

e  Programmes non identifiés dans le menu de démarrage ou dans la barre d’état du
systeme.

e Données manquantes, corrompues ou altérées.

Entretien et
dépannage
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Calendrier de
maintenance

Ce document fournit un calendrier de tests et de maintenance pour le Faxitron Path. Il est
fortement recommandé que I'entretien et les tests décrits dans cette section soient effectués
en respectant les intervalles de temps indiqués, pour s’assurer que votre générateur de rayons
X Faxitron continue a fonctionner avec des performances optimales.

Maintenance

Avertissement : les échantillons contenant des tissus peuvent abriter des agents
infectieux dangereux pour votre santé. Respectez les procédures de biosécurité
appropriées ; portez des gants lors de la manipulation des échantillons de tissus &
ou des matériaux avec lesquels ils sont entrés en contact.

Essuyez régulierement I'intérieur de I'armoire avec de I'alcool isopropylique a 70-90 % ou avec
de I'hypochlorite de sodium dilué (5,25-6,15 % d'eau de Javel domestique diluée a 1:500
fournit la concentration appropriée). Veillez a ce que la zone de I'échantillon, indiquée sur le
sol de la chambre, soit nettoyée a fond.

N’utilisez pas d’acétone ou d’autres solvants agressifs sur la fenétre de la porte de la chambre
a rayons X.

Interne

Essuyez régulierement les surfaces externes avec de I'alcool isopropylique, de I'hypochlorite
de sodium ou du savon doux et de l'eau. (Voir la Section 8.1.0 ci-dessus pour les
concentrations appropriées.) Ne trempez pas ou n’'inondez pas les surfaces et n’utilisez pas
d’abrasifs qui pourraient rayer les surfaces. Ne laissez pas 'humidité entrer en contact avec
les composants électriques du systeme. Testez les produits de nettoyage sur une petite zone
non visible des capots en plastique et en métal pour vérifier qu’ils n'endommagent pas le
revétement.

Externe

A I'exception des fusibles et des cables externes, le systéme ne comporte pas de composants
remplagables par I'utilisateur. Les éléments suivants peuvent étre commandés et remplacés
par le personnel de Hologic ou des représentants agréés.

e Détecteur de rayons X numérique.

e Carte d’interface PCle.

e Ordinateur, écran, souris et clavier.
e Carte contréleur.

e Tube arayons X et alimentation HT.

e Alimentation basse tension.

Pieces
remplacables

» Cible de diffusion en acrylique (0,25" ~ 6 mm et 1" ~ 24 mm d’épaisseur).

e Fantdme ACR (Nuclear Associates Réf. 18-250).

e Radiamétre pour chambre d’ionisation, Inovision Modéle 451B-DE-SI-RYR ou similaire.
¢ Bidon d’eau en plastique de 1 gallon (4 litres).

Matériel
nécessaire

Les références suivantes fournissent des informations qui amplifient ou augmentent les
procédures de sécurité du logiciel, qui sont définies dans ce document.

Sécurité et cybersécurité
Toute mise a jour de logiciel ou de micrologiciel effectuée depuis la maintenance précédente
et qui résout un probléme de sécurité ou de sireté peut étre fournie si nécessaire.

Le micrologiciel est codé en dur dans la carte de commande, donc si une mise a jour du
micrologiciel est nécessaire, remplacez la carte de commande du panneau de commande.

Documents de
référence et
informations sur
les versions
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Les définitions suivantes s’appliquent aux termes énumérés ci-dessous lorsqu’ils sont
mentionnés dans le présent calendrier de maintenance :

ADU : analog-to-digital units (Unités analogiques-numériques).

AEC : automatic Exposure Control (Contréle automatique de I'exposition) — L’ordinateur met
fin aux rayons X lorsque suffisamment de signal a atteint le détecteur.

Agrandissement : éloignement de I'objet du détecteur et rapprochement de la source de
rayons X pour agrandir I'image de I'objet sur le détecteur.

Bruit de lecture : mesure du bruit RMS pendant une exposition sombre de 0 seconde (pas de
signal).

Champ plat : corrections de gain et de décalage effectuées pixel par pixel. Chaque pixel a un
gain et un décalage différents et doit étre étalonné.

Contraste : pourcentage de différence entre I'intensité de I'objet et I'intensité de I'arriere-plan.

Courant d’obscurité : signal généré thermiquement dans le capteur ; (presque) linéaire dans
le temps.

Fantome ACR : fantdbme d’accréditation de I’American College of Radiology.

MTF : modulation transfer function (Fonction de transfert de modulation). Mesure du contraste
et de la résolution d’un systéme d’imagerie.

Paires de lignes par millimétre : nombre d’éléments de plomb et d’air alternés. Par exemple,
10 Ip/mm signifie => {air/plomb} {air/plomb} ... 10 fois par millimetre.

Radiographie d’échantillons : imagerie radiographique d’un morceau de tissu
apres son extraction du corps.

ROI : region of interest (Région d’intérét). Généralement une sous-région spécifique d’'une
image.

SID : source-to-image distance (Distance source-image) ; distance entre la source de rayons
X et le détecteur.

Une maintenance périodique doit étre effectuée une fois par an pour garantir que votre systéeme
Faxitron Path continue a fonctionner de maniére optimale dans le temps. Cette maintenance
périodique comprend la vérification des éléments suivants :

e Verrouillages et indicateurs de sécurité, Section 8.8.0.
e Test avec fantdbme ACR (vérification des performances de la caméra), Section 8.8.1, et

e  Contrble du rayonnement, Section 8.8.2.

Nous recommandons que ces procédures soient effectuées une fois par an, mais les
réglementations gouvernementales peuvent exiger des calendriers d’entretien plus fréquents.

Définitions

Maintenance
réguliere
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Verrouillages, voyants, messages d’erreur — A effectuer une fois par an

Imprimez cette page pour I'utiliser comme référence si nécessaire.

Enregistrez les résultats sous « Verrouillages, voyants, messages d’erreur » sur le registre de
maintenance périodique — Faxitron Path, situé a la fin de la Section.

. Le systeme doit étre sous tension. L’interrupteur a clé doit étre en position « 3 heures » et
la clé doit étre impossible a retirer.

. Vérifiez que le voyant « Power » (Alimentation) s’allume. Aucun autre voyant n’est allumé
a ce stade.

. Assurez-vous que I'écran LCD s’allume et affiche « System Idle » (Systéme inactif) et qu’il
n'y a pas d’autre message, tels que « Door Open » (Porte ouverte) a ce moment-la.

. Ouvrez la porte du compartiment a échantillon. L’écran LCD affiche le message « Door
Open » (Porte ouverte). Lorsque la porte est refermée, ce message doit disparaitre.

. Allumez l'ordinateur et I'écran. Le logiciel Vision doit démarrer automatiquement. Si le
logiciel ne démarre pas automatiquement, double-cliquez sur 'icone du logiciel Vision pour
démarrer le logiciel d’imagerie. Si cela déclenche un étalonnage, laissez-le s’achever
compléetement.

. Ensuite, cliquez sur le bouton Start Procedure (Démarrer la procédure), puis sur le bouton
Patient Data (Données du patient) et choisissez le bouton Enter Manually (Entrer
manuellement) pour accéder a I'écran de saisie du patient. Remplissez tous les champs
marqués d’'un astérisque (*) et cliquez sur le bouton « Accept » (Accepter). Cela permettra
de faire une exposition.

. Vérifiez que le voyant « Ready » (Prét) est allumé. L’écran LCD affiche également un
message « Ready » (Prét).

. Appuyez sur la touche verte « X-ray » (Rayons X) située a I'avant du Faxitron Path. Le
systéme devrait débuter une exposition aux rayons X. Assurez-vous que I'écran LCD affiche
I'indicateur a barres pour I'exposition, ainsi que la valeur kV et la durée d’exposition. Vérifiez
également que le voyant « X-Ray On » (Rayons X activés) s’allume. Un court bip est
également émis environ une fois par seconde pendant I'exposition. Laissez I'exposition
s’achever et assurez-vous que I'image s’affiche sur I'écran de I'ordinateur.

. Appuyez a nouveau sur le bouton vert pour démarrer une autre exposition. Pendant
I'exposition, appuyez sur le bouton rouge « Stop » (Stop) : normalement, le rayonnement
doit s’arréter dans les 2 secondes suivant la pression sur le bouton. Le signal sonore
cessera notamment de retentir pour indiquer que I'exposition a été arrétée. Le logiciel
affichera des erreurs d’interruption, ce qui est normal. Les erreurs peuvent étre effacées,
ce qui permet de reprendre la génération de rayons X.

10. Appuyez a nouveau sur le bouton vert et laissez le rayonnement démarrer. Cette fois, ouvrez
la porte du compartiment a échantillon ; ceci devrait déverrouiller les interrupteurs de sécurité
et forcer I'arrét du rayonnement. Le logiciel peut afficher des erreurs, acquittez-les.

Verrouillages et
indicateurs de
sécurité
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Fantéme ACR (insert en cire uniquement) — A effectuer une fois par an

Imprimez cette page pour I'utiliser comme référence si nécessaire.

Enregistrez les résultats sous « Test avec fantbme ACR » sur le registre de maintenance
périodique — Faxitron Path, situé a la fin de la Section.

L'utilisateur doit étre familiarisé avec l'utilisation du Faxitron Path et doit connaitre les
procédures de prise de radiographies. Achevez les procédures de configuration et assurez-
vous que la caméra est étalonnée (notez le kV et la durée d’étalonnage), saisissez les données
du patient et prenez une image de la partie de l'insert en cire du mini fantdbme ACR illustré a la
Figure 8.1. REMARQUE : l'insert en cire doit étre retiré de son support en acrylique.

Le mini fantdme ACR contient 12 objets :
4 masses, 4 fibres et 4 groupes de
calcifications (taches). Chaque groupe
de calcification contient 6 calcifications
ou taches individuelles. Toutes les
masses, fibres et calcifications doivent
étre visibles.

Remarque : le dernier groupe de
calcifications peut ne pas étre visible sur
cette image.

CRITERES D’ACCEPTATION

1. Configurez le systéme pour prendre une image manuelle de l'insert en cire du mini fantdme
ACR. Réglez les kV et la durée sur ceux notés lors de I'étalonnage.

2. Assurez-vous que le fantdme est propre et exempt de tout débris.

3. Placez l'insert en cire directement sur le sol de la chambre au milieu de la zone d’imagerie.
N’utilisez pas de bloc d’atténuation.

4. Démarrez I'exposition aux rayons X, attendez que tous les traitements soient achevés et que
'image soit affichée.

5. Tous les objets du fantdme peuvent ne pas étre visibles lorsque I'image est affichée pour la
premiere fois. Ajustez les niveaux de contraste et de luminosité selon vos besoins pour
obtenir une meilleure image.

6. Une fois I'image corrigée, tous les groupes d’objets doivent étre visibles.

7. Consignez les résultats dans le registre de maintenance périodique.

8.8.1
Test du fantome
ACR

Figure 8,1

Image radiographique typique de
I'insert en cire du mini fantéme
ACR (Nuclear Associates Réf.
18-250).
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Faxitron® Path

Systéme de radiographie d’échantillons

Calendrier de
maintenance

Controéle du rayonnement — a effectuer au moins une fois par an ou si le
dispositif a chuté ou a été endommagé.

Les pages suivantes peuvent étre imprimées et utilisées comme instructions aux fins du
contréle du rayonnement.

Enregistrez les résultats sous « Contréle du rayonnement » sur le registre de maintenance
périodique — Faxitron Path, situé a la fin de la Section.

Le fabricant recommande qu’un contréle du rayonnement soit effectué au moins une fois par
an* pour s’assurer que les émissions de rayonnement sont dans les limites admissibles. Si la
machine est endommagée d'une quelque fagon aprés son installation, alors le contrble
radiographique doit étre effectué avant de remettre la machine en service dans I'établissement.

Outils nécessaires

e Appareil de contréle du rayonnement avec source de contréle (radiametre pour chambre
d’ionisation recommandé, comme I'lnovision 451B, la source de contrble est fournie avec
I'appareil).

¢ Bidon d’eau en plastique de 1 gallon (4 litres).

Vérification du fonctionnement du radiameétre
1. Date d’étalonnage : vérifiez que I'étalonnage du radiametre est a jour.

2. Vérification de la batterie : vérifiez I'état de la batterie. Remplacez les batteries si
nécessaire.

3. Veérification du fonctionnement : (si la source de contréle est disponible.)
Remarque : les étapes suivantes s’appliquent & Inovision 451B ou a des radiamétres pour
chambres d’ionisation similaires. Suivez les instructions des fabricants pour les autres
radiametres.

e Ouvrez le blindage coulissant contre les rayons béta situé au bas du radiamétre.
o Réglez le radiamétre sur la source de contrdle et surveillez pendant 30 secondes.

e Le radiameétre doit donner des valeurs dans les limites de tolérance indiquées sur
I'étiquette d’étalonnage.

e Consignez les mesures dans le registre de maintenance périodique.

e Refermez le blindage contre les rayons béta du radiameétre.

Remarques importantes
1. Toutes les mesures de rayonnement sont effectuées avec le radiamétre a moins de 5 cm
(2 po) de la surface du Faxitron Path.

2.Lors de l'enregistrement des mesures de rayonnement, il peut étre nécessaire de les
multiplier par 0,1 pour convertir la lecture de uSv/h en mR/h. Par exemple, 12 uSv/h est égal
a 1,2 mR/h.

Controéle du
rayonnement
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Faxitron® Path

Systéme de radiographie d’échantillons

Calendrier de
maintenance

Procédure de contréle du rayonnement

1. Relevez une valeur du rayonnement de fond (pointez I'appareil de mesure vers le centre de
la piece) et enregistrez la valeur.

2. Configurez le systéme pour prendre une image manuelle.

a. Cliquez sur le bouton du panneau de commande du dispositif et sélectionnez Full
Manual (Manuel complet).

b. Faites glisser les curseurs kV et Time (Durée) tout a droite pour maximiser les valeurs
kV et de durée sélectionnées.

c. Cliquez sur le bouton « SET » (Définir).
3. Vérifiez que le voyant « Ready » (Prét) est allumé.

4.0Ouvrez la porte du compartiment a échantillon. Placez le bidon d’eau en plastique de 4 litres
(1 gallon) au sol dans la zone d’imagerie de la chambre et fermez la porte.

5. Appuyez sur la touche « START » (DEMARRER) et relevez les émissions de rayonnement
au sommet, a 'avant, a l'arriére et sur les deux cotés de I'armoire. Balayez lentement toutes
les surfaces avec le radiameétre. Il faut normalement compter 1 a 2 expositions aux rayons X
pour chaque balayage. Remarque : vous devrez lancer plusieurs fois les émissions de
rayons X pour effectuer le contréle du rayonnement dans son intégralité.

6. Consignez les valeurs pour chaque emplacement de test.

7.Si l'une des valeurs est supérieure a la limite d’émission de rayonnement du Hologic
a hauteur de 0,1 milli-Roentgen (mR) par heure (1,0 uSv/h) en un point quelconque situé a
5 centimétres (cm) a I'extérieur de la surface externe (*), contactez un représentant de
Hologic pour discuter des options de réparation.

(*) 0,5 mR/h a 5 cm des surfaces externes est la limite supérieure fixée par le CDRH de
la FDA américaine pour les équipements a rayons X montés en armoire. Si I'appareil
est utilisé dans un autre pays, veuillez vérifier les limites officielles du pays pour les
appareils a rayons X montés en armoire utilisés a des fins de diagnostic.

Pour certains pays, les points de test doivent étre a 10 cm des surfaces externes et
dans ce cas, I'émission de rayonnement des systémes doit étre inférieure a 0,1 mR/h a
10 cm des surfaces externes.

8. Retirez le bidon d’eau de la chambre a rayons X.

9. Le sol de I'armoire de radiographie doit étre analysé si le systéme est posé sur une table ou
s’il y a du personnel a I'étage inférieur. Vérifiez qu’il n’y a rien dans la chambre a rayons X,
lancez une radiographie et balayez le fond de I'armoire. Enregistrez les mesures.
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FaXitrO n® Path Calendrier de

Systéme de radiographie d’échantillons maintenance

Registre de maintenance périodique — Faxitron Path

N° Série du systeme : N° Série de la caméra :

Verrouillages et indicateurs de sécurité — Conformément a la section 8.8.0

Réussite : Echec : Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

Test avec fantdme ACR — Conformément a la section 8.8.1

Nombre d’objets observés : Masses : Fibres : Groupes de calcification :

Réussite : Echec : Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

Contrdle du rayonnement — Conformément a la section 8.8.2

Lectures du rayonnement en : |:| mR/h DuSv/h Source de controdle :

Arriere-plan :

Avant : Coté droit : Dessus :
Retour : Coté gauche : Dessous :
Réussite : Echec : Initiales : Date :

En cas d’échec, indiquez la raison et les mesures prises pour corriger cet échec.

Initiales : Date :

La maintenance périodique susmentionnée a été effectuée par:

Date de I'exécution : Signature :
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